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Where do I see Views / Monitoring / Alerts etc for my technology?

Open the Operator’s Console, Click the Monitoring Pane and expand the folder that corresponds to the

technology that you’re interested in. If there is no folder for your technology, either the view is secured

so that you can’t see it, or (more likely) the management pack is not imported.
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Something shows as Red. How do I figure out why it is showing as Red?

With the item in Red is Selected, click ‘Health Explorer for ...."” On the right-hand side of the console:

1 OpsMgrlitware.com - Windows Virtual PC
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PR System Center Operations Manager 2007 R2 - antr2
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This will show the monitors that determine the health of the object you were looking at in the previous
view. Click on the monitor that shows as Red and then click on ‘State Change Events’ :
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B Health Explorer for MSPetShop
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In the above example, if we look in the SQL active alerts, there is also an alert indicating this problem:

NOTE: This alert will also be visible in the top level active alerts view which displays all new alerts,
regardless of the management pack that it comes from:
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In this case, there is a task available (visible either in the alert view or state view) that will resolve the

problem:
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= System Center Operations Manager 2007 R2 - ankrZ
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The Task will run to set the DB online:
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‘ou can close this dialog at any time. Daoing so will not intetrupt executing kasks, You can

check the status of tasks in a task status view,
Close |

Running kasks ... @) Help Moas?®
Task | Skatus | Task Target |
'_{%Set Database Online Skarted mspetshop

Task Output ==l Copy Text == Copy HTML

¥l Task Status - Set Database Dnline i ] 4

A

The Task output will display if the task completed successfully:

Operations Manager 101
6|Page



B, Task Status - Set Database Online TS|
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In SQL, the DB shows as online again, and after Operations Manager detects the online state of the DB
(hourly by default), the State of the DB will change back to green in Operations Manager and the alert
will get automatically resolved and disappear from the active alerts view:

System Center Operations Manager 2007 R2 - antr2
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How do I get more detail on what is in my Technology’s Management

Pack?

Download the Management Pack Guide:

For an Overview of the Management Pack including what

it monitors, how it works, what configuration

is required etc., review the Management Pack guide. Download the Management Pack guide using the

following steps:

1) Go to the Management Pack catalog at:

http://pinpoint.microsoft.com/en-US/systemcenter/managementpackcatalog

2) On the right hand side, narrow it down to the Operations Manager version you need (Operations
Manager 2007 R2 is the latest version and the one that you will normally want):

/& Microsoft System Center Management Pack Catalog - Windows

Internet Ex|

I'm looking for: Companies Professional Services

O@ v.: thpomt.m\cmsoft.mm'En-U /systemcenter/managementpackcatalog
m Edit View Favorites Tools Help
% % Windows Live Bing B v © WhatsNew Profile Mail Photos Calendsr MSN  Share | 8 = [ = % | Sign
¢ Favorites .‘ Microsoft System Center Management Pack Catan. | [ AR v [ @@ v Page~v Safety~ Tools~v (@
United States ~
Get Listed | Help | About Pinpoint | Dashboard | Sign In

oo ooy JSICY

Microsoft*

;% System Center | Management Pack Catalog

Featured Plug-ins

System Center Management Pack for APC InfraStruXure Central
By: APC

Price:Free

APC

Microsoft Systems Center Operations Manager 2007 Management Pack far
APC InfraStruXure Central is a vendor-neutral, scalable menitering system
which collects, organizes, and distributes critical alerts, surveillance video and
key information, providing a unified view of complex physical infrastructure

[Syslem Center

System Center Catalogs by Product

Configuration Manager 2007
Data Protection Manager 2007
Essentials 2007

Operations Manager 2005

Operations Manager 2007

environments from anywhere on the network.

[

Operations Manager 2007 R2

PowerWF Studio for System Center

virtual Machine Manager 2008

3) In the ‘Search Applications’ box type the name of the Management Pack that you’re after, e.g. SQL

Management Pack:
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http://pinpoint.microsoft.com/en-US/systemcenter/managementpackcatalog

United States
Get Listed | Help | About Pinpoint | Dashboard | Sign

I'm looking for: Companies | Applications | Professional Services

Browse by Category ~ - oF - [Q sl management pack ] (Syslem Center |~ ﬂ

You searched for sql management pack

Narrow My Results [ ] Apps Found: 4
App T
ST 1] Sort by Best Match ~
All App Types -
Microsoft SOL Server Management Pack for Operations Manager 2007 (2)
Industry Focus Plug-in by: Microsoft System Center
All Industries hd Price: Free

System Center Pack for: SQL Server Ver: 6.0.6648.0 The SQL Server Management Pack provides the
canahilities for Onerations Mananer 2007 to discover SOI Server 2000. 2005 and 2008 installations and

4) Click the Title hyperlink to take you to the pinpoint details for that Management Pack, and click the
download button:

United States ~
Get Listed | Help | About Pinpeint | Dashboard | Sign In

I'm looking for: Companies | Applications | Professional Services

- or- (Q sgl management pack (System Center | - E

Microsoft System Center (o reviews - Review this company)
Redmond, Washington, USA | View Map & Address

> System Center

a\ Company Overview ﬁ Apps + Services "\Q Reviews J Locations

Microsoft SQL Server Management Pack for Operations

Manager 2007 (Rated by 2 customers) Price: Frea
Features —————————
App Type: Plug-in

2 pme Fieeal 4 -

5) This will take you to the Microsoft download site to download the msi:
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Click Here to Install Siveright United States Chal

Microsoft oing 2|

Download Center

Download Center Home Search Al Downloads. - Advanced Search

Product Families
:”f‘g::”‘ Microsoft SQL Server Management Pack for Operations Manager 2007

e Brief Description

Elsh=Es SIS The Microsoft SQL Server Management Pack for Operatians Manager 2007 provides discovery and monitoring of SQL Server 2000, 2005 and 2008.

Developer Tools

Windows Live On This Page

= & Quick Details & Overview

Games & Xbox % System Requirements + Instructions

Windows Mobile + Related Resources % What Others Are Downloading

All Downloads
Download Categories
Games
DirectX

Quick Details
Internet
Windows Security & Updates R BEEEED
Windows Media Date Published: 11/24/2008
Drivers Language: English
WD Q@ Download Size: 46 KB - 3.5 MB*

Mobile Devices

*Download size depends on selected download components.
Mac & Other Platforms " "

System Tools

NOTE: you can also ‘Bing’ something like ‘SQL 2005 management pack operations manager 2007
download’ which will often take you to the same end page (shown above) much quicker.

6) Run the MSI and this will extract the files in the management pack

NOTE: It will not try to install / import the management pack. It will simply just extract the files.

NOTE: One of the files will be a .doc guide which is the MP guide. The rest of the files (.MP extension)
are the Management Pack files that need to be imported into Ops Mgr.

7) To get more complete detail than that which is posted in the MP guide (i.e. a complete list of all rules
/ monitors etc. in a management pack, download and extract the MPViewer tool ZipFile from:

http://blogs.msdn.com/boris yanushpolsky/archive/2008/06/25/mpviewer-1-7-now-works-with-latest-
el2-mp.aspx

NOTE: MP viewer requires the Ops Mgr Operator’s console (as it uses some dlls from it).

8) Open MPViewer and navigate to the extracted .mp files:
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http://blogs.msdn.com/boris_yanushpolsky/archive/2008/06/25/mpviewer-1-7-now-works-with-latest-e12-mp.aspx
http://blogs.msdn.com/boris_yanushpolsky/archive/2008/06/25/mpviewer-1-7-now-works-with-latest-e12-mp.aspx

g5l Management Pack Viewer s .
File
7 [
ot Open

w 3
Uv| |, % Local Disk (C) » Products » OpsMgr2007 » MPsFromMS.Com » sgl6.0.6648.0-22nd)uly02

Organize » MNew folder

Sk Favorites MName : Date modified Type Size
,_9 Bing Search | Microsoft.5QLServer.2000.Discovery.mp T/8/2009 1:40 AM MP File 46 KB
Ml Desktop | Microseft.5QLServer.2005. Discovery.mp T/8/2009 1:40 AM MP File 114 KB
& Downloads | Microsoft.5QLServer.2005.Monitoring.mp  7/8/2009 1:40 AM MP File 310 KB
|43 el | Microsoft, ErVEr. Discovery.mp 18/ A0 Al ile
H mweb Mi ft.5QLS 2008.Di 7/8/2009 1:40 AM MP Fil 110 KB
| 5 MSW Intranet | Microsoft.5QLServer.2008 Monitoring.mp  7/8/2009 1:40 AM MP File 306 KB
£ Recent Places | Microsoft.5QLServer.Library.mp 7/8/2009 1:40 AM MP File 130 KB

=l Libraries E
@ Documents
Aﬁ Music
[=] Pictures
?; Podcasts
E# videos

1% Computer
9 Local Disk (C) | |
—a EliteSilver-Labs A
ca Local Disk (Qr)

File name: Microsoft.5QLServer.2005.Menitering.mp hd [SEE|Ed MP files (*.mp) ']
[ Open |v] [ Cancel ]
il

9) Click on ‘Monitors — Unit’ and / or ‘Rules’ to see the Rules and Monitors:

40 Management Pack Viewer - SQL Server 2005 {Monitoring) 6.0.6648.0 l w [ [t

File
~Classes I Name | Target Category Enabled 0. Co.. F Event|D Event Source i
Console Tasks L
- Dependencies MET Framework runtime was shut down by user code SQL 2005 DB Engine EventCollection True 6537 STanget/Property[Type="5Q|
- Diagnostics A default full4ext catalog does not exist in the database... SQL 2005 DB Engine EventCollection True 9967 STarget/Property[Type="5QI
.. Discoveries Afatal emor occumed in MET Framework rurtime SQL 2005 DB Engine EventCollection True 6536 STarget/Property[Type="5QI|
- Groups A security (SSPI) emor occumed when connecting to an...  SQL 2005 DB Engine EventCollection True 9643 STarget/Property[Type="5Q|
Linked Reports A 5QL job failed to complete successfully SQL 2005 Agent EvertCollection Tue
| - Monitors - Aggregate A SQL Server Service Broker conversation closed due .. SQL 2005 DB Engine EventCollection True 9761 STarget/Property[Type="5Q1
- Monitors - Dependency A SQL Server Service Broker cryptographic operstion f...  SQL 2005 DB Engine EventCollection True 9641 STarget/Property[Type="5Q|
(| i Monitars - Unit A SQL Server Service Broker procedurs output resutts SQL 2005 DB Engine EventCollection True 9724 STarget/Property[Type="50|
- Owvenides Agent shutdown. For more information, see the SGL Ser... SQL 2005 Agent EventCollection True 20557 £Target/Host/Property[Type _|
Recoveries —— . e R ._NT - P, - . — o eee
- Relationships
I Reports Knowledge | Raw XML
- Tasks
- Views
|
|
i
i
I
i
I
i
I
(| -
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NOTE: You can also sort by Category to show all the event rules / performance rules together.

Also you can save to HTML / Excel using the pull-down file menu.
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How do I disable or tune something in Ops Mgr?

All Configuration changes in Operations Manager (Enabling / Disabling / Tuning) are performed using

overrides which are stored in unsealed management packs.

In the example below, this database is showing as ‘Warning’ because the Auto Close flag is set to True:

‘A System Center Operations Manager 2007 R2 - antr2

File  Edit Vi

Monitoring Actions

= |9 Moritoring 2l 4 Lookfor: Find How Claar ate Actions
'2| B24 event
ﬂ 530 events S0L (4 Health Explorer For
4] Active dlerts State 5 |17) Name Path e E)DEDFslle | WS5_Search_OPS
Discovered Inventory Group
. " W] Start Maintenance
disk test 1\, Warning WS5_Search_OPSMGR opsmgr.litware. com; MICROSOFT##55EE = Mode...
I_] Es;:k:ilt‘;ﬁsvisgma“ms @ Healthy ReportServer opsmgr. likware, com; M3SQLSERVER. Edit Mainkenance
- ~ Mode Settings. .
Task Status () Healthy Los Conkoo
i Urie/Linux Servers @ Healthy aithERR IDEEHIDN
22| “windows Computers -
1 [ Microsoft SOL Server ©
[ 4] Active Alerts () Healthy
i] Emfgie’: () Healthy Health monitors for W5 5_Search_ (PSMGR Knowledge | Siate Ehenge Events (4]}
ask Status = o
= EE Databases () Healthy [ & _:5 Ertity Health - WSS _Search_OPSMGR [Entity) Time: From Operational Stale a
542] Database Free Space 2 Heakhy (2) Bwalbilty - W5S_Sasrch_OPSMGR [Enii) A b
3] Database State - Configuration - w55 _Search_OPSMGR (Entity) - .
5] Trarmaction Log Fres Spe 2 et 73\ o Close Flag -WSS_Search OPSMGR (SEL 2 | 5/14/2010 302 P Py @ Auto Clase Setting DK
£ Health Moritoring () Healthy % Auto Creale Statistios Flag - W55_Search_OPSME | 3/8,2010 10.:37 AM @ a Aula Clase Setting Mot 1K (08
Perfarmance ~ () Auto Shiirk Flag - W5S_Search OPSMGR (S0L 2 58
% Replcation @ Healthy (%) ko Update Flzg - WSS, Search_OPSHGA (ST 2422/2010 938 PM @] @ Auto Close Setting 0K
ER Server Rokes () Healthy ~(2) DB Chairing Flag - W55_Search_OPSMGR, (S0L: - se
L4 501 Agent (2) Healthy -(_) Tom Page Detection - W35_Search_OPSMGR (31 Ditls
- - . WSS_Content- -]
=1 [ Microsoft Windows Server - (&) Perfomance -w/SS_Seaich_OPSMGR [Enliy] - false 58 b
() Healthry () Gesuity - \WSS_Search_ DPSMGR [Entiy) e State
Active Alets - Y = = ¥ WSS_Content-DBChaining false
Logical Disk State () Healthy WSS_Content-AutoClose false ement
Metwork Adapter State () Health WSS_Content-AutoShrink false
E Operating System Performanc WSS_Content- e r
Task Status AutoCreateStat
Windows Server State ;SB&GT&SPSHG“' jrue]
= £ Health Maritaring @ oopd: !
&l ne SQL 55_Search_OPSMGR-| ng
8] Disk Health omPagebetect false]
= Name ectio
|_] Metwork Adapter Health o SS_Search_ OPSMGR.]
8] Operating System Heaﬁ'j Dat ;’ DBChaining] faice
0| B atab: 55 _Search OPSMGR-] -
o Recow AutoClose] e on
Shaw or Hide Views Databs '55_Search OPSMGR faise} b
New iew » m—— AutoShrink]
SS_Search_OPSMGR-| frue] sis
AutoCreateStai]
J Monitoring A
— ..
'—_ Collation Latin1_General_CI_AS_KS_WS
F"-" eporting Log Size (MB) (String) 17.8125
Log Size (MB) (Numeric) 17 @ gyps;ean;‘ OC:snter
B, H orspace 0y System Center
Operations
r ] Manager Online

An alert is also visible both in the Active Alerts and SQL alerts views:
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PR System Center Dperations Manager 2007 R2 - antr2

File  Edic

Monitoring

=) ] Maritoring
Iﬂ] 624 event
2] B30 avents
|A] Active slerts
| Discovered Inventory
disk test
Distributed Applications
Iﬁ] Security Events
Task Status
Unis/Linus Servers
‘windows Computers
=l L2 Micosot SOL Server
|4 Active Alerts
Computers
& Task Status
=l |25 Databases
@ Database Fiee Space
\E] Database State
4] Transaction Log Fres Sp=
23 Health Maritoring
L3 Perfomance
3 Fieplication
L3 Sewver Fioles
3 SOL Agent
B 23 Microsolt Windows Server
Active Alerts
Logical Disk State
Metwork Adapter State
g Operating System Perfoimanc:
& Task Status
wfindowss Server State
&=l 25 Health Monitaring
48] Disk Health
2] Network Adapter Health

&3] Operating System Health
< il

Show or Hide Views.
New View »

Active Alerts

J‘Look far: Find Mow Clear X Alert Actions -
i | Fath | Source |@| Name Resoluti... | Created Age | () Wiew or edit the
settings of this
= Severity: Critical {13) manitor
& opsmar liware....  SQLSERVERAGENT 208 no suppress New 4/27/2010 1:42:07 P 17Days, 23 Ko, M 15 Close Alert
& opsmar liware....  SQLSERVERAGENT 208 no suppress New 3(BI2010 11:42:17 AM &8 Days, 1 Minute [l 5 properties
& opsmar liware....  SQLSERVERAGENT 208 no suppress New 3i8i2010 11:12:10 AM &8 Days, 51 Min... [ (5 Health Explorer
& opsmar liware....  SQLSERVERAGENT 208 no suppress New 3(8i2010 12:12:20 PM &7 Days, 23 Ho... W87 Start Maintenance
&) opsmar litware....  SQLSERVERAGENT 208 no suppress New 2{12{2010 9:38:57 AM 92 Days, 2 Hour... Mode...
[%] It MSSQLSERVER P worke [l 3/9j2010 2:46:32 PM 66 Days, 20 H 2 Edt Mainkenance
opsmgr ltware.... M5S0 racess Worker ap... New 1942010 2: 46+ ays, 20 Ha... Mot Settngs. .
& opsmar ltware....  MICROSOFT##SSEE The SQL Server Ser... Mew 2j23[2010 8:38:01 AM &1 Days, 3 Hour... ! Stop Maintenanice
&) opsmar litware....  SQLSERVERAGENT 208 no suppress New 2{12{2010 9:37:27 &AM 92 Days, 2 Hour... Made
@ opsmar.itware....  SQLSERVERAGENT 208 no suppress Mew 3(8(2010 10:42:09 &M 68 Days, 1 Hour. .. % Qwverrides »
&) opsmar litware....  SQLSERVERAGENT A5GL job failed to ... New 10/1242009 11:42:04 PM 214 Days, 13H... | [5G Personalize view...
&) opsmar ltware....  SQLSERVERAGENT 208 no suppress Mew 4)2212010 10:12:20 &AM #3Days, 2 Hour... WGunseription 4
&) opsmar ltware....  MSSQLSERVER The 50 Server Ser... Mew 9{11/2009 12:11:21 PM 246 Days, 32 Mi... 2 Creste
) opsmariware, W35_Search_OPSMGR #uto Close Flag New 5{15/2010 12:04:47 PM 39 Minutes ﬂ Madfy
I=l Severity: Warning (1)
| S0L Database Tas...a
_;S opsmgr ibware....  SQOLSERVERAGENT SQLServerdgent co... Mew 1/24/2010 6:27:54 PM 110 Days, 17 H...
—
Check Catalog
= (oecc)
[ Cherk Database

@ Auto Close Flag Alert Description

| WSS _Search_OPSMGR

Source: The auto dose flag for database W5S_Search_OPSMGR in SQL instance
MICROSOFT##55EE on computer opsmar.litware.com is not set

FT##SSEE\WSS_Search_OPSMGR accarding to best practice

lert
Moni

Created:

(O Auto Close Flag

2010 12:0¢

J Monitoring

E l!! ing
Epﬂr ng

mlms ration
'!P orkspace

Knowledge: I View additional knowledge. .

Summary

This monitor checks the Auto Close setting for this database. A warning or error alert will be raised if it does not match the required
setting.

Qut of the box, the monitor is configured to alert when this setting is True. This can be changed using overrides as required.
Causes

2n unhealthy state is caused by the Auto Close setting for the database not matching the specified setting (False is the default)
Resolutions

This issue may be resolved by changing the Auto Close setting on the database.

(DBCC)
[ check Disk (DBCC)

[ |

Set Database
Offline

[ et Database
Online

[ |

Set Database to
Emergency State

0L Management
Studio

0L Profiler
| S0L Database Re...
Alert Logging

Latency

o

Alerts
Availability

Configuration
Changes

Everlt Analysis

Health

NOTE: Although the state of the object (database) shows as warning, a critical alert is raised. This is the

way the monitor has

been configured in the sealed SQL Management Pack:

Clicking the Alert Monitor hyperlink (red box in above screenshot) will take you to the Monitor / Rule

properties:
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i Auto Close Flag Propetties ﬂ

Company Fnowledge I Owvernides I
General Health |.-“-‘-.Ierting| Diagnostic and Fieccnveryl I:l:unfiguraticunl Froduct knowledge

Map monitor conditions to health states

Specify what health state should be generated for each of the conditions that thiz monitor will detect;

M onitor Condition Cperational State Health State
2 Auto Cloge Setting OF. +] Healthy
Configuration Yalue ... | Auto Close Setting Mot OF, ﬁ}, W arning

i Auto Close Flag Properties ]

Company Knowledge | Ovemdes I
Generall Heslth Alerting |Diagnu:|$tiu: and Fiec:cw'eryl Ennfiguratinnl Product Knowledge

Alert settings

¥ | Generate alerts fior this maritar

Generate an alert when:

IThe morikor iz 0 a warning health state j

¥ tutomaticaly resolve the: alert when the: moritan retums toa bealthy state

Alert properties

Alert name: Pricirity:
Auto Close Flag IMedium j
Alert dezcription; Severity:
The auto cloze flag for databaze $T arget/Froperty Al iz =
[Type="50L! L |Crlica [

icrozoft SALServer. D atabaze'")/DatabaseMames in SOL
instance $T arget/Hozt/Property[Type="S0LI

Microzaft SOLS erver. ServerB ole"/ I nstanceM amed on

computer $T arget/Host/Host/Property[Type=""windows!
Microzoft \Windows. Computer'[/MetworkM ame$ is not set ;I

PPN R WU Y S Ty

The one place where configuration changes (Enabling / Tuning / Configuration are allowed in in the
Overrides tab of the rule / monitor properties:
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Auto Close Flag Properties ]|

Eienerall Healthl Alerlingl Diagnostic and Fleu:u:wer_l,ll Eonfigurationl Product Knowledgel
Company Knowledge Ovemides

Owvermides are uzed to change the monitor, diagnostic and recovery configuration. vou can also
wigw all overrides applied to each by opening the summary dialog.

Choose the monitor, diagnostic or recovery from the list below for which you want to apply
overmides for or wiew summary on:

Manitor [Auta Cloze Flag)

Dizable... |

Examples

Dizable a monitor: | want to dizable monitor for all Windows Computers.
Oweride a diagnostic: | need to overnide thiz diagnostic for one of my WWindoy

YWiew summary of a recovery: | need to view the objects thiz recovery haz been enabled tar.

Clicking the Override button presents a number of objects:

e Forthe Object: (The configuration change will apply to the one object you accessed the monitor
properties through (that the alert was raised for) — in this case the one DB -
WSS _Search_ OPSMGR

e For all Objects of Class: This will override for every object that the Monitor is targeted to (in this
case all SQL Databases that Ops Mgr has discovered — i.e. all SQL servers that have the agent
installed

e Foragroup: You can create a group of databases in the authoring space, and then select the
group to create the override against. The pre-created group

e For a specific Object of Class: Clicking this will give you a list of all SQL databases and you can
pick the one that you wish to create the override (configuration change) for.

e For all objects of another Class — This option is very rarely used. Only used if relationships are
involved.
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Once the scope of the option is selected, you will see the same following dialog, whichever object you
selected:

Override Properties x|

onitor name: Auto Close Flag
Categon: Configuration Health
Owerrides target: Object; WSS _Search OPSMGR
Qverride-controlled parameters:
Owveride | Parameter Mame ¢ | Parameter Type Default Walue | Overide YWalue | Effective Yalue | Change Status Enforc
- Alert On State Enumeration The monitar ... | The monitor iz... | The monitor iz... | [Mo change] -
- Alert Pricrity Enumeration Medium b edium I edium [Mo change] -
- Alert severnty Enumeration Critical Critical Critical [Mo change] -
- Auto-Aesolve Alert Boolean True True True [Mo change] -
[l Dizable Check for 5. | Boolean True True True [Mo change] [l
» Enabled Boolean True True True [Mo change] [l
[l Expected Value Boalzan Falze Falze Falze [Mo change] [l
[T |Frequency [seconds] | Integer 43200 43200 43200 [Ma change] [l
- Generates Alert Boolean True True True [Ma change] -
T | Timeout [z=c) |rteger 300 300 300 [Ma change] -
4| | i
Details:
Enabled Description Edit...
The parameter iz not zet by a custom ovemde or by a
management pack. The effective value of this parameter
iz the default value of this parameter.

Management pack

Select destinatioh management pack:

IDefauIt Management Pack j MHew... |
Help | 0K | Apply | Cancel |

4

If you want to disable the rule for the object selected, place a check next to the ‘Enabled’ Parameter,
change the Override Value to False and then Change the Management Pack from something other than
the default Management Pack

NOTE: The golden rule of Ops Mgr configuration is to NEVER store anything in the default Management
Pack. Best practice is to store the override in an unsealed Management Pack created for all Overrides
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for your particular technology’s sealed MP. So in this case you would have a [Company Name] SQL
Overrides MP and that would be the appropriate place to store your overrides. If such a Management
Pack does not exist, you can easily create it here, using the New button.

Once configured, it should look something like this to disable the monitor:

i x|
1 Monitar name: Auto Cloze Flag
1 Categony Configuration Health
1 Dwverrides target; Object: WS5_Search OPSMGR
! Overide-controlled parameters:
! Owveride | Parameter Hame <+ | Parameter Type Default Walue | Overide Walue | Effective Walue | Change Status Enfore
! - Alert On State E numeration The monitar . | The monitor iz | The maonitor iz | [Mo change] r
! - Ailert Pricrity E numeration tedium redium td edium [Mo change] r
! - Alert zeveriy E hurneration Critical Critical Critical [Mo change] -
! - Auto-Resalve Alert Boolean Tiue True Tiue [Mo change] r
! - Dizable Check for 5... | Boolean True True True [Mo change] r
! » v Enabled Boalean True True [Added] -
! (Il Expected W alue Boolean Falze Falze Falze [Mo change] il
i - Frequency [zecondz] | Integer 43200 43200 43200 [Mo change] r
i - Generates Alert Boalean True True True Mo charnge] r
! (Il Timeout [zec) | nteger a00 300 a00 [Mo change] il
1] | i
I Details:
i | Enabled Description Edit
The new custom overide will be created in the ‘antoni
I SOL Overrides MP.Click apply to wiew the new
effective value for thiz parameter.
I Management pack
t Select degtination management pack:
i antoni SOL Overides MP Mew. ..
I Help | ] 4 Apply | Cancel |
f 4
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Clicking OK will complete the override and the change will be automatically sent to the agent, so that
the Auto Close flag monitor gets disabled for the DB on this one SQL server.

Note that the other parameters above (like frequency of the check, severity of the alert, expected value
etc.) can all be overridden here also. The Management Pack Author determined what parameters are
exposed as overrideable so the overrides dialog always shows the entire scope of what can be
configured for a given rule or monitor.

The monitor properties (and the overrides tab) can also be accessed from the health explorer view that
is accessed from a state view:

A System Center Operations Manager 2007 R2 - antr2

File  Edit

Monitoring Database State

= .Q Monitoring ~fl 3 Lok for: | Eind How Clear ¥ || State Ac

(2] 624 event

: soLzoos | <M @ Heal
[l B30 events State o [ Name Path () DE File ] @ Wss
(LA Active Alerts Group MGR
£ Discoversd Inventory 1\ Warning W33_Search_OPSMGR apsmgr litware, com; MICROSOFT##35EE = start

7| disk test

=] Distributed &pplications () Healthy ReportServer opsmgrlitware. com;MSSOLSERVER M:de
2] Security Events () Healthy WSS _Corkent apsmarlitware.com; MICROSOFT##55EE &t

z Task Statug

<) Health
ﬂ UrigdLinus Servers () Hethy
] Wwindows Computers () Health

B |23 Microsoft SOL Server () Health
|LA] Active Alerts .
@ Computers 8 Healthy Knowledge State Change Events [4] I
o Task Status ) Healthy :
2 [ Databazes @) Heatth = Entity Health - WS5_Search_OPSMGR [Entity] | To | Operational State
H Database Free Space ki @ Luailability - WSS _Search OPSMGRE [Entity]
[}| Dabasesiate (&) Healthy 1\ Configuration - W5 5_Search_OPSMGR, (Entiy
=k - | i P T i Auto Close Setting 0K
ransaction Log Free Spz @ Healthy @
Health Monitaring - Auto Close Setting Mot OK
= (&) Healthy -(2) Buto Shiink -
L8 Perfomance Auto Close Setting OK
cati (&) Health () Auto Updat a
L{ Replication 'y !
L3 ServerRoles (2) Healthy 8 ?B Cga'”‘”;
i L SOL Agent om Page
# LE 4 gen () Healthy Perf 4 s
B [£F Microsoft Windows Server effarmance - false
[ 4] ctive Alerts () Healthy O Secury -wof nt-DBChaining false
=] Logical Disk State () Healthy oo tontent-AutoClose false
|EJ Metwork Adapter State WSS _Content-AutoShrink false
gj Operating System Perfarmanc 4 WSS_Content- frue
; Task Status AutoCreateStat
[352] "windows Server State 55_Search OPSMGR
1 £ Health Monitoring Sulud Bt ies )
5] Disk Heath & squ 55_Search_OPSMGR- =
isk Healll — omPageDetectio
48] Metwork Adapter Health o 55_Search_OPSMGR- =
8] Operating System Health'Ll Sl DBChaining]
al | Databe

Configuration changes (Overrides) can be viewed using the overrides view:

NOTE Right-click the view and use the Personalize view to Group by ‘Override Management Pack’ or
‘Override Target Management Pack’ for a more useful view:
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Personalize Yiew

Columns to display @+ | 4 | Sort colunins by
[s] Crverride Target I(None) j 1o &scendin.g
[w] Context " Descending

[w] Parameter

[l Default value
[w] Owverride Value
v Scope Group items by
[w] Management Pack Object Type
[w] Enforced

o

Ascending

Owvertide Management Pack,

[w] Target

[w] Crverride Management Pack. Overtide Targer

[w] Target Management Pack Override Target Management Pack
[w] Owverride Target Management Pack Override Value

[l Created Parameter

Target Management Pack

Reeset bo Defaulk | QK I Cancel

=8 System Center Operations Manager 2007 R2 - antr2

Actions

Clear Override

B |4 Authoring
Z§‘ Management Pack Templates

%Look For: I Eind Mow

Owerride Target | Context ‘ Parameter Default Value Cvertide Value Scope B Erforce

Distributed Applications
P GEroups Override Management Pack: Antoni DFS Overrides Custom MP {3) X Delete
= % Management Pack Chjects

(i) Attributes = Override Management Pack: antoni SQL Overrides MP {2) T Override T
) Monitars = Target: SQL Database {2} E Personalizg
i, o -
b gb]e‘th'm"e”es 9 futo Close Flag opsmar ltware.... Enabled True False Object Froperties
B> overrides B
B> Database Status opsmar liware,,..  Frequency {sec,., jec
5 Rules Database Stak [ F i 3600 &0 Object || Resources
Zf Jervice Level Tracking Override Management Pack: antoni test mp (7) @ System Cel
=| Tasks Manager H
verride Management Pack: Client Monitoring Overrides Management Pacl
[ views Dverride M. t Pack: Client Monitoring Overrides M. t Pack (1) @ Svstem
ystem Ce
Override Management Pack: Data Warehouse Internal Library (3) Manager
Override Management Pack: Data Warehouse Library {3) Help
averride Pak: Default Pack (4) @ nchust vor
Overrides

=

Override Management Pack: Litware.com Dist app mp (1)

3]

Override Management Pack: MOM 2005 Backward Compatibility (4)

=

Override Management Pack: System Center Core Monitoring {16)

3]

Override Management Pack: Windows Cluster Library (1)

Add Monitoring Wizard..,
Mew Distributed Application. ..
Mew Group, .

Epurlng
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How do I create a rule to be alerted on a scenario such as a user being
added to domain admins?

Go to the Authoring space

1) Launch the Operator’s Console (Start>All Programs>System Center Operations Manager 2007
R2>Operations Console)

2) Click the ‘Authoring’ space on the bottom left hand side.
3) Right-click Management Pack Objects>Rules and choose ‘Create a new rule’
4) In the dialog, expand Alert Generating Rules>Event based

5) Click NT Event Log (Alert)

NOTE: A Golden rule of Operations Manager is to NOT store anything in the Default Management Pack.
See Section M of this document for explanation why.

6) Change the Management Pack from Default Management Pack to an appropriate Management Pack.
If there is an MP where all the company’s custom rules and monitors are stored (or even better an MP
where the organization’s AD or Auditing Rules / Monitors are stored), then select it from the dropdown.
If not Create a new Management Pack by clicking the New button, give it a name, hit Next and Create)

7) With NT Event Log(Alert) and the appropriate Management Pack selected, click Next:

Operations Manager 101
22 | Page



[E Create Rule Wizard
- Select a Rule Type

Fiule Type @ Help
General

Select the type of rule to create

Event Log Type

=155 Alert Generating Rules =
5125 Evert Based
Corfigure &lerts ,JE Genenc C5Y Text Log [Alert)
[l Generic Test Log [4lert]
N [ NT Event Log [Alert) | |
1 Snmp Trap [Alet]
JE Svslog [&lert]
-5 WM Event [Alert)
=125 Collection Rules
E| |25 Event Based
JE Generic C5V Text Log
JE Generic Text Log
JE WT Event Log
15 SMMP Event
15 SMMP Trap (Event) |

Description:  Generate an alert in respanse to *Windows events

Euild Event Expression

Management pack

Select destination management pack:

Y2 Antoni A0 Scenario Rules Management Pack

< Brevious Mext > | Create | Cancel

8) Give the rule a name (For Example: ‘XYZ Alert generating Rule for User Added to Domain Admins 632
Event’)

NOTE: It is best practice to use some form of prefix or three-letter acronym as a naming convention, to
identify all of an organization’s custom rules and monitors. This makes it much easier to find custom
rules in the console when necessary.

9) Click the ‘Select’ button next to the Rule target box and choose an appropriate target such as
'Windows Domain Controller and click OK.

NOTE: Because the 632 event will only occur on domain controllers, it is appropriate to target the rule to
the Windows domain controller object. If the event could occur on any windows computer, use
‘Windows Operating System’ as your target. Best practice is to be as specific as possible.
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NOTE: Start typing the name of the object desired in the ‘Look For’ box to narrow the list down, and If
the object you‘re after is not available, click the ‘View all targets’ radio button.

Select Items to Target I

Select the class. group. or object that you want to target from the list Below. You can also filter or sort the list to make
iterns easier to find.

Look for:

Iwindows doma Clgar |

i+ Yiew common targets

" iew all targets

Target - | Management Pack | Desc_ﬂi:tion |

79 tatal Targets, 2 visible, 1 selected

Help | ok I Cancel |/
3

10) Leave the defaults of ‘Custom’ as the Category, ‘Rule is enabled’ checked and then click Next

NOTE: By leaving the Rule enabled, the rule will become active on every instance of the object you
target the rule to (e.g. every windows computer / every windows domain controller depending on the
object that you target). To target a specific instance or a subset of instanced, uncheck the ‘Rule is
Enable’ box to disable it by default and then following the creation of the rule, Create an Override to
enable for an instance or group of instances.

Operations Manager 101
24 | Page



JEE create Rule Wizard

n Rule Name and Description

Rule Type

General

Evwent Log Type

Build Event Expression

Configure Slerts

&) Help

Select rule name, description and target
Rule hame:
Y2 Alert Generating Rule for Uzer Added to Domain Adming B32 Event
Description [Optional)

[ |

|
M anagement Pack: wrZ Antoni A0 Scenanio Rules Management Pack
Rule Categon: Custom j
Rule target;
\windows Domait Controller i Select.. I
¥ Rule iz enabled

< Previous Nest > Create: Cancel

11) In the Event Log Name, type the word Security, or alternatively, click the 3 dots and select the

Security Event Log, and click Next.

NOTE: This is nothing to do with the targeting. This is purely to make sure you get the name of the
event log correct with no typos. The Rule will look in the selected event log on every object targeted
(e.g. every windows computer or domain controller) that has the selected event log.
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[iE Create Rule Wizard X Change Scop

‘ Event Log Name
nagement Pack | Created
AL Tk @ Help  tonitest mp 4f2af20
General i
Specify the event log to read the events from oni test mp 4f29/20
Event Log Type ltoni test mp 55/201
Specify an event log name ta read events from. You can browse to a computer to view and select .
Build Event Exprassion fram awalable evert logs. roni test mp 42920
Configure Alets rori test rp 429/20

Log name:

Securty m
Select Event Log 3

Browse or enter computer name

Computer:

OPSMGA _al

Available event logs

Select event log to use:

Actual Hame | Friendly Name

Application Application

Internet Explorer Internet Explorer

0ODiag Micrazoft Office Diagnastics
Operations Manager Operations Manager

05 ession
S ecuiity y
Syl em

‘windows PowerShell “windows PowerShell

Microsoft Dffice Sessions

Mate: Actual log name will be stared in the Operations Manager database.

< Previous Mest > Mot all Windows Event Logs may be listed. However, pou may manually input
the name of the log if you wish

Monitoring
0K Cancel
L [

12) In the Value box on the Event ID line, type 632

NOTE: If you wish to monitor for a separate Event, simply specify the alternative Event ID here.

13) Click the grey cell next to Event Source (the second line) and click the Delete button in the Ul

14) Click the Insert button (the main button not the drop-down section of it) and then click the 3 dots on

the new line that appears

15) In the 'Select an Event Property' dialog' chose 'Specify event specific parameter to use' and change
the value from 1 to 3 and click ok:
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select an Event Property

YYou can reference event properties that are commaon to all events.

“fou can also select event specific properties in the form of event
parameters. Refer to the specific event documentation for details.

™ Select from a list of common event properties:
| =

% Specily event specific parameter to use:

Ewent parameter number; 3=

" Usze parameter name not specified above:

0K I Cancel

16) In the operator field on the second line choose Equals

17) In the value field on the second line, type Domain Admins (Case-sensitive):
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x

n Build Event Expression

Fule Type .@ Help

General 3
Filter one or more events

Ewent Log Type

. X Build the expression to filker ane or more events:
Build Event Expression

Configure Alerts #Ingert - | Delete )( Fgrmula'gf,'|r
FParameter Hame | Dperator | Walue \

= AND group (all of these are true]
Event ID Equals B32

<Erevious| Hest » I Create Cancel |

4

NOTE: For monitoring users added to a group other than Domain Admins, simply type the Alternative
Group name in place of Domain Admins. As well as Equals, other operators such as ‘contains substring’
or ‘Matches Regular Expression’ are available.

18) Click next.

19) In Alert name either leave the rule name as the default (the rule name), or change this to a more
meaningful string such as ‘XYZ - User Added to Domain Admins'
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IE Create Rule Wizard =
‘ Configure Alerts

Fiule Type .@ Help
General

Specify the information that will be generated by the alert
Event Log Type
Build Event Expression Alert name: Prigrity:
Configure Alerts 2 - User Added to Domain Admins IMedium j

Alert description: Severity:

Event Description: $0ata/E ventD escriptiond | ICriticaI j

Custom alert fields... Alert suppression...
< Previous Tewt > I Create I Cancel |
4

NOTE: the next step is optional. By default, only the contents of the event description will be displayed.
Following the optional step below will deliver a more meaningful phrase at the top of the alert

description:

Optional Step) In Alert description, click at the start of the box (before Event description) and type
SData/Params/Param[2]$ Was Added to $SData/Params/Param[3]$

and the result should look like this:

SData/Params/Param[2]$ Was Added to SData/Params/Param[3]$

Event Description: $Data/EventDescription$
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IE Create Rule Wizard

n Configure Alerts

Fiule Type .@ Help
General

Specify the information that will be generated by the alert

Event Log Type

Build Event Expressinn Alert name: Prigrity:
Configurs Alsits IXYZ - User Added to Domain Adming IMedium j
Alert description: Severity:
$D ata/Params/Param[2]$ was Added to $Data/Params/Param _I IEnticaI j
[31%

Ewent Description:
$D ata/E ventDescriptiond

Customn alert figlds... Alert suppression...

<Erevi0us| IHest > | Create I Cancel |

4

20) Change the Priority and Severity if desired, and click Create.

NOTE: Before testing the rule by adding a user to Domain Admins, ensure that the series of 1200, 1201
and 1210 events is observed in the operations manager event log on the Windows Domain Controller
that you are monitoring

I Ei Event Yiewer
File  Action iew Help
-~ R FER| 2=
@ Event Yiewer (Local) Dperatio anage
----- 4| Application
----- 4| Security
----- 4| Syskemn
_____ 1| Directory Service G)Information 5j10/2010 :03:02PM  HealthService Health 5... 1201 MfA DCo1
..... G Information  5f10/2010 002:32 PM HealthService Health 5... 1200 1) D01
4| DNS Server — — —
..... 1| File Replication Service 1) Infarmation  5/10£2010 D02:29PM  HealthService Health 5... 7025 [ DCo1
e b Bl G)Information 5/10/2010 9:02:29PM  HealthService Health5... 7024 MjA DCo1
LIl KB4 Operations Manager ] Gplnformation 5{10/2010 902:29PM  HealthService Healths... 7025 {1 Dot
J
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Event Properties

Ewent |

D ate:
Time:
Type:
Uzer:

BA0A20010  Souwrce: HealthService
0232 P Categony: Health Service

Information  Ewent [0 §1200

M A

Computer: DCOT

Dezcription;

i

For more information, zee Help and Support Center at
hittpe g, ricrazaft comdbalink./events. o,

Mew kanagement Packlz] requested. b anagement group “antr2",
configuration id:"A4 98 23 91 BA FSEE 34 82 DE 8C 8B 68 33 A5 64 4B
B13EDI"

Ewvent |

Date:
Time:
Type:
Uzer:

Event Properties

EAM0/2010  Sowce:  HealthService
0802 P Categony: Health Service

|nformation Exent [0 § 1201

f A

Computer; DCO1

Dezcription:

i ®

MHew Management Pack with
id: e Antani AD . Scenano. Rules. M anagement. Fack”, version:'.0.0.0"
received.

Far more information, zee Help and Support Center at
httpe A fgo. microzoft, comdfelinkAevents. aso.
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Event Properties

Uzer:

Ewent |

D ate:
Time:
Type:

EAD/20M0  Source:  HealthService
9:02:11 P Category: Health Service

Information Event [D: 11210

AL

Computer: DCOT

Dezcription;

Mew configuration became active. Management group antr",
configuration id: A4 98 23 91 BA FI EE 34 82 DE 8C 8B 62 33 A5 64 4B
B13EDI"

Far mare infarmation, see Help and Support Center at
httpe o rmicrozaft comdbalink/event s asp.

Now, test the rule by adding a user to domain admins on the DC, and you should see a new alert appear

in the Monitoring>Active Alerts view of the Operator’s console:
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R 5ystem Center Operations Manager 2007 R2 - antr2

Monitoring Actions
= (5 Moritaring 3 Look far: EndMow  Clear % || Alert Actions a 4
(2] 624 event - = =
[t2] 630 evenls Severty | L | Source | %) Hame Resoldtion State | Created Age |Last 2l O :x‘aetgn?;rsaudf‘tt ':?Sem‘a
= Llerts Critical 0O litwars, com 12 - User Added b Domein Adrins e 5{10/2010 %:12:36 PH <1Miruks 5100 P
L& Close Alert
Discovered Invertory Critical a DC01 litware, com User added to Domain Admins Tew 5/10/2010 9:12:36 PH <1Mnote  5/10
disk test [ Properties
Distibuted Applcations warning  {\ opsmgr.litware.... Service Cherk Data Snurce Madule Failed Execu,.. Hew 2{27(3010 9:36: 33 PH 6 Days, 2... 5/10 @ Hodth Exlarer
(2] Seouity Events Critieal @) Microsoft(R) Wi.. Antori Test Proc moritar Mew 5{10/2010 8:15:00 PH Saminutes  sfa fl ——
£ Tosk Stets Critical @) Microsoft(R) Wi Antoni Test P it s 5/10/2010 8:17:45 PH sstinges o || % ooy Mantenance
T Titical ferasoft(R) Wi . Ptori Test Proc moritar e {10/20110 8:17: nutes 5 Mads...
\windows Computers Warning  f\  opsmar litware.... Service Check Probe Module Faled Exertion  Hew 21222010 9:36: 34 PH 6 Days, 2... 5[0 < Edit Maintenance
i Made: Settings...
(3 Agentless Exception Monitoring Critical (@3 MICROSOFTA##... The SOL Server Service Braker or Database Mir... Mew 2(2H/2000 83801 AM 76 Days, 1., 50w 008 Sertings:
[ antoni Base 05 Dverides MP

¥ Stop Mainkenance

[2d Antori DFS Overrides Custom MP Mode
[Z1 antoni SGL Overnides MP ) W ovenides »
[Z3 antoni System Center Overrides MP ~p -
[ antoni test mp @ xvz - user Added to Domain Admins Alert Description [ Personalize view. ..
53 antoni view mp LITWARE \StewieGriffin was Added to Domain Admins | subscription &
4 DataWarehause _ A
[ Litware.com Dist app Source: [ DCOLlitware .com Event Description: 2
PR mp o . . 7] Create...
@ Microsoft Audit Collection Services Security Enabled Global Group Member Added: y "
i =] Modify...
% Microsoht SCL Server Member Name: cn =Stewie Griffin, CN=Users,DC =litware, DC=com -
Microsoft Windows DFS Mamespace: | Windaws Comput...a
[ Microsoft Windows DFS Replication | 720 DCOLlitware.com Member ID: LITWARE \StewieGriffin
(28 Micrasoft Windows Intemet Informati Target Account Name: Domain Admins L) Computer
L Microsoft Windows Server R : . Management
-
Eg MNetwork. Device Target Domain: LITWARE |25 Display Account
Settings
L4 Operstions Managsr Alert XVZ Alert Generating Rule for User Added to Domain Admins 632 ) I , -
[ Gynthetic Transaction Rule: @ Event Target Account ID: LITWARE\Domain Admins [ Display Active
Cannections
= ngAppllcatlo.n Caller User Name: administrator —
3 Windows Service Aind Frocess Monit [, Display Active
[23 Y2 Antani AD Scenario Rules Man Caller Domain: LITWARE Sessions

-
Display Local L:
Caller Logon ID: {(0x0,0xE1120) g Display Local Lsers

Created: (2010 9:12:36 PM :i Display Metwork.
Privileges: - Shares
4 » —
D D) Dispey Server
i Skatistics
Show or Hide Wiews... Knowledge: [5F View additional knowledge. . =
New View » L5 Display
Mo knowledge was available for this alert, Whorkstation
— Skatistics
__] Monitoring Hide knowiedge [ 1PCanfig

E utho ng [ List Processes
= 0l

.:3 List Services

Reporting

LE Fing Computer

!g .nministratiun =) Ping Computer

{with Raute)
B, My Wnrspace [F Ping Computer
Cantinuoushy (ping
] -t)
- -

NOTE: Unless any matching subscriptions have been previously created that match the new alert, a
notification email will not be sent out. In order to be notified by email when this happens, use the
following steps in the next section:
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How do I create a Subscription which will notify when a given alert
occurs.

1) With the Alert Selected, on the right-hand side in the Actions pane, hit the Create hyperlink
underneath subscription:

5] Create...
“-] Modify...

NOTE: If the Actions Pane is not visible, use the View>Actions Pull-down menu to make it visible:

System Center Operations Manager 2007 RZ - antr2

Go  Actions  Tools  Help

Mavigation Pane alk+F1

Actions Chrl+T

= |_-;| b oniton ﬁ;‘

[zl B2:ff

1k Fior: I Find Mow Clear
by |¢$ | Saurce | @| Mame
Detail Pane Chrl+D g By opsmarliteare, . Service Check Data Source Module Failed Execu

Find ChH+F @ D01 libware.com ¥YZ - User Added ko Domain Admins

2) Optionally, rename the Subscription Name and the Description or leave the defaults and click Next:
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ication Subscription Wizard

d%. Create Notification Subscription

LIT'WARE StewieGriffin was Added to Domain AdminslIE vent Description: 15 ecurity Enabled
Global Group Member Added:m kember Name: cn="5 tenwie

Griffin,EM=Uszers, D C=litware,D C=comBl  Member ID: LITWwWARE S tewisGriffirl
Target Account Marme: Damain Adminsll T arget Domain: LITwWARED

Target Account 1D: LITwARESDomain &dmindl  Caller User Mame:  administratoll

Caller Domain: LITwaRED Caller Lagon 1D: [0:0.0<E 17 200m Privileges:
1

3) In criteria, leave the defaults selected and click Next:
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B Notification Subscription Wizard

E Criteria

Dezcription

Criteria
Subscrbers
Channels

Surnmary

Subscription Criteria

Wwhen alertz are generated for the objectzs that match the criteria zpecified below,
notifizationz will be zent to specified subzcribers.

Conditionz

[Tiraized by any instance in a specific group s

[] raized by any instance of a specific class
[w] created by gpecific rules or monitors [e.g., sources)

[] raized by an instance with a specific name
[[] of a specific severity

[7] of a specific priarity

[ waith specific rezolution state

[ waith a specific name

[ with zpecific text in the dezcription

[7] created in specific time period LI

Criteria description [click the underlined walue to edit]:

Matify on all alerts

created b_l,l[XYE Alert Generating Rule for zer Added to Domain Sdmine 632 Event] rules ar

NOTE: By clicking the hyperlink, alerts from other rules and monitors can be picked and added to the

subscription.

4) In the subscribers Dialog, Click Add, then click the Search button to find the available subscribers:
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‘ Motification Subscription Wizard il i I = s;:tin‘;scg
76 Days, 2., 510
JR— 5/ JE Close Ale
. inutes
Subscribers ' Propettied
23 Minutes 5/10
(), Health Ex
- 23 Minukes 510 —]
Description WA} Stark Mair)
1 Hour, 18 ... 510 “" Mode...
Criteria Subscribers 1 Haur, 18 ... 5/10 o Edit Maint
Subsoribers Specify the subscribers to be notified by this notification subscription. 76 Days, 2... 510 Mods Set
, Stop Main|
Channels - Mgclije
To define new subscribers, click Mew. To add subscribers who are already defined, click [
Summary Add, % Overrides]
[I§ Personalia
!LIBSCI'IDEIDD
Selected subscribers: '&JNBE"' &7 Edit... #ﬂdd“' X Remove. .. 2
—5] Create...
Mame | Channel Tupe | .

To add subscribers, search for the subsciber by name and then add them to the selected objects list.

Filter by: [optional]

Auwailable subscribers:

Mame | Channel Ty... |
EJ LITwARE Wadministrator E-bail [SM...

:5_4 LITwWaRE Mdvanced E-Mail [SM...

NOTE: If the subscriber you need is not listed, you will need to use the ‘New’ button in the previous
dialog to create an appropriate subscriber with the desired email address.

NOTE: It is best practice to use predefined Distribution Lists as Subscribers and specify the DL in
Operations manager as the deliver address, rather than specify individual email addresses

5) Click the ‘Add button to add the subscriber to the list of selected subscribers and click OK:
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Filter by: [optional]

Subscriber Search

Ta add subzcribers, zearch far the subscriber by name and then add them to the zelected objects list.

2| x|

Avyailable subzcribers:

Search |

Mame | Channel Ty... |
_.Pl] LITwWARE NAdministrator E-tail [SM...
.&4 LITwWARENADvanced E-Mail [SH...
By Zsecps E-Mail [SM...
Selected subscribers: . ﬂl
Mame | Channel Ty... |
0 Zsecps E-Mail [SM...

Cancel |

v

6) In the Subscribers Dialog click Next
7) In the Channels dialog, click Add

8) In the Channel Search Dialog, click Search

9) Select the Email Server, click Add, and click OK:

Operations Manager 101
38| Page



Filter by: [optional]

Channel Search

To add channels, search for the channel by name and then add them to the selected channels list.

Available channels:

Search |

Selected channels:

Chanmel | Channel Type | E ndpaint |
f\l] Email Server E-tMail [SMTP) SMTPErdpoint for Email Server
@SMTF’ Channel E-Mail [SMTP] SMTPEndpoint for Email S erver

Hemove |

Chantel

| Channel Tupe

| E ndpaint

@ Ermail Server

E-Mail [SMTF]

SMTPErdpoint for Email Server

Cancel |

4

10) Leave the default setting of ‘Send Notifications without delay’ selected and click Next:
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B8 Notification Subscription Wizard

JE. Channels

11) Review the Summary, leave the checkbox enabled and click Finish:
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B Notification Subscription Wizard x|

E Summary

Dezcrption

Criteria
Subzcribers
Channels

Surnrnary

Confirm notification subscription settings

Mame
e - Uzer Added to Domain Adminz

Description
LITwWaREwas Added to Domain AdminsE vent Description: Secunity Enabled Global Group
tember Added: Member Mame: ch=5tewie Griffin, CH=Uzers, DC=ltware DC=com

M ember (D LITwWARE Target Account Manme: Dromain
Adming  Target Domain: LITwWARE Target Account [D: LITWAREAdmine
Caller Uzer Mame:  adminiztrator Caller Dramain: LITwARE
Caler Logon ID:  [0x0.0=<E17120] Privileges: -
Critenia
Aoty ot aff aferds whane

created by ¥y Alert Generating Rule for Uszer Added to Domain Adming 632 Event rules or
ronitors [g.9., sources]

Subscnbers
rsecOps

Channels
Email Server

Iv Erable this notification subzcrption |

< Previous Hest = | Finish I Cancel |

A

12) Test the Rule again, and this time in addition to seeing the alert in the Active Alerts View of the
console, the selected subscriber should also receive an email similar to the one shown below:
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System Center Operations Manager 2007 R2 - antr2

Active Alerts

Actions

a x_:-—,_.| tonitoring

3 antoni Base 05 Overides MP

[E3 &ntoni DFS Dverrides Custom MP
23 antoni SQL Overides MP

[ antoni Spstemn Center Overrides MP
[21 antoni test mp

23 antoni view mp

LA DetaWarchousa

[ Litware.com Dist app mp

(28 Micrasaft Audit Collection Services
Microsoft SOL Server

Microsoft Windows DFS Namespace:
Microsoft Windows DFS Replication
Microsoft Windows Intemet Informati
Microsoft Windows Server

Network Device

Operations Manager

Synthetic Transaction

il ol il

<
&
3
S
£
=
o
&
=}
g

L4 Windows Service And Process Monit
[2 %¥Z Antoni AD Seenario Fules Man

I — | =)

Show or Hide Views
New View »

;___] Monitoring
E .nutur q
=
r-l Reporting

v Administration

“ My WDrspace

Efstart| | &

@ XYZ - User Added to Domain Admins

Source: [ DCOLlitware.com

Path: DCO1.litware.com

Alert XYZ Alert Generating Rule for User Added to Domain Admins 632
O Event

Rule:

Created: 5/10/2010 9:42:52 PM

Knowledge:

No knowledge was available for this alert.

Hide knowiadge

J System Center Opera...

Alert Description

LITWARE \StewieGriffin was Added to Domain Admins

Event Description:
Security Enabled Global Group Member Added:

Member Name: CN=Stewie Griffin, CN=Users,DC =litware,DC=com

Member ID: LITWARE\StewieGriffin

Target Account Name: Domain Admins
Target Domain: LITWARE

Target Account ID: LITWARE\Domain Admins
Caller User Name: administrator

Caller Domain: LITWARE

Caller Logon ID: (0x0,0xE1120)

Privileges: -

f View additional knowledge. ..

4 Laok Far: EindNow  Clear H]
2] 524 event -
ﬁ 590 everts Severty | L | Source | )] Wame Reesolotion State | Created hge | Last =
LA Active Alerts Critical (23 D01 ibware.com RVZ - User Added to Domain Admins New S{10/2010 9:42:52 PM <1Mnute  5/10
g'slf?"et’e‘j Inventory Warring 1\ opsmar.ftware Service Check Data Source Module Failed Execu... Mew 2122/2010 9:36:33 PM 76 Days, 2... 5/10
sk, tes
Distributed Applications Critical @ Microsaft(R) wi... Percentage of Committed Memory in Use is too .. Mew 5102010 9:34:00 PM 8 Minutes 5/10
\’_’] Security Events Critical a Dol litware, com VI - User Added to Domain Admins New S/10/20109:12:36 PM 30 Minukes 5/10
2 Task Stah
ask AlalE Criical 3 DCOLliware.cam User added to Domain Admins Mew S{L0/2000 912236 PM 30Minutes 5710
Uniis/Linus 5 ervers
“Windows Compuiters ritical licrosol v, nkoni Tesk Proc monitar = BE:H jour, 24 ...
p Criticsl 3 Microsoft(R) Wi Ankani Test P it N S{10{20010 8:16:00 P 1 Hour, 24 ... 5/10
[ Agentless Exceplion Monitaring Criical @3 Micrasaft(R) Wi... Ankani Test Frac manitor Tew 5{10/2010 8:17:45 FM 1 Hor, 25 ... S/10w

() Wiew or ed the
settings of this rule

L5 Close lert
[ Properties
(3, Health Explorer

I Start Maintenance
Made...

Edit Maintenance
Made Settings...

3 Stop Maintenance
Mode

T overrides »

[ Personalize view. ..

!uEscrlp!lon .

“2] Create...

“2] Madify...

| windows Comput...~

5 Computer
Management

[ Display Acrount
Settings

[ Display Active
Connections

[} Display Active
Sessions

[ Display Local Users

[T Display Metwark
Shares

=
Display Server
- Statistics

[T Display
‘workstation
Statistics

5 tecanfig

=

[ List Processes

3 ist Services

[ Ping Computer

[ Ping Computer
fwith Route)
(5 Ping Computer
Continuously (ping
i
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All Alert: User added to Domain Admins Resolution state: New

OM@litware.com [OM@litware.com)]
Sent: Monday, May 10, 2010 9:53 PM
To:  Administrator

Zlert: User added to Domain Admins

Source: DC0l.litware.com

Path:

Last modified by: System

Last modified time: 5/10/2010 $:42:58 PM

2lert description: LITWARE\StewieGriffin Was Added to Domain Admins
Event Description: Security Enabled Global Group Member Added:

Member Name: CN=Stewie Griffin,CN=Users,DC=litware,DC=com
Member ID: LITWAREMStewlieGriffin
Target Account Name: Domain Admins

Target Domain: LITWARE

Target Account ID: LITWARE\Domain Admins
Caller User Name: administrator

Caller Domain: LITWARE

Caller Logon ID: (0x0,0xE1120)

Privileges: -

Zlert view link: "?DisplayMode=Pivot&RlertID=%7bcdS2cd2d-545%c—-4bT7b-810£
57a2ded5155a8%74"

Notification subscription ID generating this message: {BS51C0FSA-0151-
$9795-4827-8DFB5BD340D5}
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How do I know if OpsMgr is collecting a specific performance counter?

The first thing to determine is whether the performance data you need is already being collected in
Operations Manager. The easiest way to do this is to create a view showing all performance counters

In My Workspace, Right-Click My favorites, choose New>Performance View:

R System Center Operations Manager 2007 R2 - antr2

Eile  Edit

—

My Workspace

Actions

Clear

View Type Open

Performance View  Open K Delete

@ System Certer
Operations Manager
Help

2 System Certer
Operations Manager
Onling

_

Howr ko Create a
Favorke Yiew

(@) How to Personalize 2
View

New View »

Monitoring

= |
! ! Aministralinn

B, My Workspace

Give it a name such as ‘All perf’, leave all the other default settings, and click ok to create the view:

Operations Manager 101
44 | Page



T

Mame:
IP.II perf]

Description:

Criteria |Displa\; |
Show data related to; Show data contained in a specific group:

| Entity | | EID | | gear|

Select condikions:

[ collected by specific rules

[] with a specific object name
[] with a specific counker name
[] with a specific instance name

Criteria description (click the underlined value to edit):

View performance

Ck I Cancel

Change the “All Items’ to ‘Items by text Search’ and type part of the performance object or counter that
you're interested in. For this example, we are looking for SQLServer: SQL Statistics\Batch Requests/sec.
Typing Statistics into the look for box, returns all counters / objects / rule names that have the word

statistics in the title:
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PR System Center Dperations Manager 2007 R2 - antr2

All'Perf

My Workspace

= 48 My Workspace
= ¥ Favorite Views

e all parf

(3, Saved Searches

0.5

0
5/14i2010 4.00 PM

5114/2010 8:00 PM

5115/2010 12:00 AM

5/15i2010 4:00 AM

5(15/2010 8:00 AM

5f15/2010 12:00 PM

Counter

?’g Save Image As..

Copy Image ta
Clipboard

|53 Copy Datato
Clipboard

[ Select Time Range...
[id] Personalize view...

Baseline

Resume the Baseline

Pause the Baseline

1| Reset the Baseline
Resources

@ System Center
Operations Manager
Help

»

2% System Center
Operations Manager
Orline

el

]

(@ About Maintenance
Mode

(5) Add New Views of
Monitoring

(@ How to Personalize a
Wigw

(@ About Tasks

(&) Target Monitoring

(@ About the Command
Shell

- j— opsmgr... MSSQLSERWER  SQLServer:Broker Statistics-SQL RECEIVEsfsec-1... SQLSERVER:Eroker Statistics 5QL RECEIVEs ser
- opsmar.., MSSQLSERYER  SQL User Connections SQLSERVER.: General Statistics User Connections
Mew Yiew » [ — opsmar,., MSSQLSERYER  SQLServer:iBroker Statiskics-S0QL SENDs/sec-15.0-,,, SQLSERVER:Broker Statistics S0L SEMDs/sec
[T == opsmgr... MSSQLSERYER Collect SQL Compilations Per Second SQLSERVER:SGL Statistics SQL Compilations|sec
R - opsmar... MSSQLSERWER SQLServer:Broker Statistics-Enqueusd Messages/... SQLSERVER:Broker Statistics Enqueusd Messages/sec
7 T [T = opsmgr... MSSQLSERWER SQLServer:Broker Statistics-Broker TransactionR... SQLSERVER:Eroker Statistics EBroker Transaction Rallbacks
[T == opsmgr... MSSQLSERWER Logins per Second SQLSERVER. General Statistics Loginsfsec
REPO 2 [T == opsmgr... MSSQLSERVER SQLServer:Broker Statistics-Enqueued Transport ... SQLSERVER:Eroket Statistics Engqueued Transport Msgs)sec
5 ad o
orksp
4] l

The above view shows that only the only counters collected by default for the SQL Server: SQL Statistics
object are SQL Re-Compilations/Sec and SQL Compilations/Sec. This means we need to create a
performance collection rule to collect the data that we want to collect and present in the above graph.
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How do I create a rule to collect performance data that is not already
collected in a management pack, and show it in the graphs in Operations

Manager?

1) Navigate to the ‘Authoring’ Space of the console. Expand Management Pack Object and right-click

Rules and choose ‘Create a New Rule’

[=] System Center Operations Manager 2007 B2 - ankr2

File  Edit

Authoring

Bl |4 Authoring
g Management Pack Templates

4 Laok Far: I

Marme

Distributed Applications
£ Groups
=] % Management Pack Objects
i=| Attributes
) Manitars
L‘:jg Ohject Discoveries
e

= Type: Agent (153)
| Service Check Probe Moduls Execd
JE Replacement Failure For Suppressi
IJE OleDb Probe Module Events Callec
IJE 115 Site State Data Source Module

hpatibility Appy
Nodule Initiali
IJE Alert on Backward Compatibility Sci
IJE Collect System’Syskem Upkime

IJE Application Log Maodule Execution A
JE Parameter Replacement Failure Ev
IJE Backward Compatibility WMI Event
IJE Collect Consolidator Module Events
[ collect Expression Fiter Module Ev
JE Alert on Failed Batch Responses
IJE Service Check Probe Module Initiali
IJE Collect Health Manager Events
[ collect Object State

_IE Service Check Probe Module B

Management Pack: System Centd

Target: Health Servic
Add Monitaring wWizard, . knowled iews knowled
Mew Distributed Spplication, .. nowsHge: I RS

Created: 9f8/2009 8:2

Mesww Group, ..

' DI'IIDI“II'Ig

E‘ Authoring

_=""||_RWF_—
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2) Select Collection Rules>Performance Based> Windows Performance, and change the management
pack to something other than the Default Management Pack and click Next:

[E Create Rule Wizard

n Select a Rule Type

Fiule Tyupe

General

Select the type of rule to create

Ferfarmance Caunter

@ Help

[ptimized Collection

Description:

B+ Alert Generating Rules

E] Evert Bazed

=15 Collection Rules

E] Event Bazed

EIE Perfarmance Based

JE SHMP Perfarmance
E Wikl Performance

YWwindows Performance

#-1 Probe Based

=% Timed Commands

..... JE Execute a Command
----- JE Execute a Script

Collect Windows performance data

Management pack

Select destination management pack:

Antoni Custom Rules

< Previous

Hext > |

Create |

Cahcel

2

3) Give the rule a name (I recommend using a prefix to the rule name such as a 3-letter acronym of the
company name as this makes it easier to find objects such as rules in the console), select a Rule Target
that will be present on the computer you want to collect the performance counter from. In this case an

appropriate target is SQL 2005 DB Engine, and then click Next:
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[E Create Rule Wizard

n Rule Name and Description

Fiule Type .@ Help

General o
Select rule name, description and target

Performance Counter
Fiule name:

(O ptimized Collection - —
Antani Perf Rule SOLServer: SOL Statistics\Batch Requests/sec

Drescription [0 ptional):

Management Pack: Antoni Custom Rules
Rule Category: Custam d
Fiule target:

[SEL 2005 DE Engine

Select the class, group, or object that you want ko target from the list below. o
itemns easier to find.

¥ Fuleis enabled Look for:
Isql

' Vfiew common targets

" View all targets

< Previous Mest >
| - Target ~ | Management Pack | Description
SOL 2005 Analysis Services  SOL Server 2005 [Discovery]  &n installation ol
05 DB Enc SHL er 2005 [0 Ty | aff

SOL 2005 Integration Servi.. SL Server 2005 [Dlscovery An installation
S0L 2005 Reporting Services  SOL Server 2005 [Discovery]  &n installation ol
S0L DB Engine S0L Server Core Library An installation o

4) In the following dialog, ignore everything else and click the ‘Select’ button;
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m Create Rule Wizard |
n Performance Object, Counter, and Instance
Fule Type .@ Help
General Specify the performance counter
Perfarmance Counter Enter perfformance counter details or click Select to browse computers and zelect details.
[ptimized Callection Object:
i
‘Wildeard characters * and 7 are supported for advanced scenarios. Click help for more
information.
Counter:
Instance:
[ il
[ Include all instances for the selected counter
Select... |
Specify the interval
Inteneal:
I 15 I Minutes j
< Previous I Tewt s [Create Cancel |
4|

In computer, Browse to a computer that has the performance counter you need to collect and the
available object and counters in the list will refresh.

NOTE: This is purely for picking the correct counter. By selecting a computer to pick the counter from,

you are not saying ‘l just want to target this one computer’. Because in the previous dialogs we selected

SQL 2005 DB Engine, the performance counter rule will be activated on every Operations Manager agent
where a SQL 2005 DB engine object and the counter picked out is found.

Pick the appropriate object and counter and click OK:
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Select Performance Counter

Browse or enter compuber name

Computer;

OPSMGR [

Performance counter

Object:
I SOLServerSOL Statistics j

Select counter from list: Select instance from lizt

.-'f-.ut-:u-F'aram Altempts/sec

Failed Auto-Params sec
Forced Parameternzations/sec
Safe Auto-Farams/zec

SOL Attention rate

S0L Compilations/zec

50L Re-Compilations sec
Unzafe Auto-Paramsfzec

Explain |

[T Alllinstances

Ok

Cancel

Configure the interval / instances as required and click Next:
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' Performance Object, Counter, and Instance

SOLServerSOL Statistics IF

Batch Requests/sec

= T

Leave the defaults in the Performance Optimization dialog, and click Create:
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Fiule Type
General
Performance Counter

Optimized Collection

IH Create Rule Wizard

n Optimized Performance Collection Settings

Using optimized data collection for performance counters results in lower accuracy, but
uzes lesz bandwidth and saves space in the database. Increase or decrease the
optimization level for a performance counter by increazing or decreasing the tolerance.

High optimization Low optimization
- Stores less data in the databaze - Stores more data in the database

- Less accuracy - More accuracy
- Uses less bandwidth - Uses maore bandwidth

ﬂ\/ﬁ ﬂ\w]‘ talerance
talerance

#* Collected zample
* Mot collected sample

Set tolerance to:

& Shsolute number: |5 3:
! Percentage I1D 3:

< Previous Tewt > | Create I

@) Help

Cancel |

y,

NOTE: Performance Optimization will drop samples that are within a specified range (based on absolute
number or percentage) of the last sample collected. This is to reduce space in the database.

After the collection interval that you specified has past, you will see the data in the all performance view
that you created. Click on the ‘Show’ checkbox to display the data. Note you can click on the graph to
show the value of the data, or use the ‘Select Time Range’ option to show a more granular range:
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R System Center Operations Manager 2007 R2 - antr2

Fle  Edit

My Workspace

= 4% My Workspace
=) % Favarite Yiews

g Al perf

(3, Saved Searches

PM PM PM PM PM

Items by text search -

0
51520 511520 5/15/20 51520 515720 5/1520 51520 515720 51520 51520 5/1520 51520
10250 10255 103:00 103:05 10310 10315 10320 10325 10330 103:35 10340 10345

PM PM PM PM

skatistics

Show | Calor | path | Targer

| Rule

PM PM PM

+ | obtect

I ﬁ Seleck Time Range. ..

Performance Actions

Efy Save Image As...
fg Caopy Image to Clipboard
23 Copy Data to Clipboard

Personalize view. .,
Baseline

Resume the Baseline

Pause the Baseline

Reset the Baseline
SOL DB Engine Tasks

[ Global Configuration Settings

._E SQL Configuration Manager

LE‘ SQL Management Studio

(5 salL Frofiler

.:3 Start SQL Agent Service from DB Engine

[ Start SQL Agent Service on Cluster from DB Engine
[ Start SQL Full Text Search Service

:i Start 5L Full Text Search Service on Cluster

[ start SQL Server Service

:3 Stark SQL Server Service on Cluster

:3 Stop SQL Agent Service from DB Engine

:3 Stop SQL Agent Service on Cluster from DB Engine

¥ —— opsmarlitwa... MSSOLSERVER

Antoni Perf Rule SQLServer: SQL Sta.

.. S0LServer:SQL Statistics

Stop SQL Full Text Search Service
Stop SQL Full Text Search Service on Cluster

OEEmar . v, . PSSl SERVER

Talect SUL Lompianons Per Secarnd

ISR VERT S0 SEarstes

J73 stop SQL Server Service

Mew Wigw » opsmgr.litwa,..  M35QLSERVER.

Collect SQL Recompiles Per Secand

SQLSERWER:SGL Statistics

[ Stop sl server Service on Cluster

apsmar.litea, . M33QLSERVER.

Logins per Second

SQLSERYER:General Skatistics

ngine Reports

apsmar.litwa, . MSSQLSERVER.

S0QL User Connections

SQLSERYER:General Skatistics

Alert Logging Latency

opsmar.itwa... MSSQLSERVER

SGLServer:Broker Statistics-Broker T...

SQLSERWER:Broker Statistics

Alerts

opsmar.itwa... MSSQLSERVER

sGLServer:Broker Statistics-Enqueue. ..

SQLSERYER:Broker Statistics

Awvailabilty

opsmar.litwa...  MSSOLSERVER

S0LSarver:Broker Statistics-Enqueue. ..

SOLSERWER:Broker Statistics

Configuration Changes

opsmar.litwa...  MSSOLSERVER

SLServer:Broker Statistics-SQL REC...

SQOLSERVWER:Broker Statistics

Event Analysis

mlinliniiniinlininlinliy

apsmagr.litwa... MSSOLSERVER

SQLServer:Broker Statistics-SQL SEN...

SQLSERWER:Eroker Statistics

Health

SQL Broker Performance
5L Server Configuration

NOTE: The data shown above will go back 7 days by default (unless the settings in
Administration>Settings>Database Grooming for performance data have been changed):
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=] System Center Operations Manager 2007 R2 - ankr2

8 Administration
Connected Management
L?;; Device Management
ﬂ°'- Agent Managed
E‘g Agentless Managed
Management Servers
2 Retwork Devices

UnizfLinu Servers
'_ig‘ Management Packs
= Motifications
=L Channels
4] Subscribers
'Ell Subscriptions
2 Product Conneckors
0 Internal Connectors
% Run As Configuration
Accounts
Prafiles
(%] Security
£ User Roles

@ Settings

Discovery Wizard. ..

EIE—

\.kl;ook for: I Eind Mow

Clear

Actions

x Actions

Mame

[ Properties

= Type: Agent {1}
1] Heartheat
= Type: General (5)

g Pending Managementl -';]b alerts

|| Database Grooming
ﬁ? Privacy
Reporting
@ web Addresses

= Type: Server {2)
1] Heartheat
() Security

|Jl Database Grooming Descrip!

Database Grooming
- Remove unnecessary data fror

lonitoring

E !!H ng

Global Management Group Settings - Database Grooming

Resources

@ Syskem Center Operations M.

ll perations M

General |
the Agent
Database Grooming Settings:
Alerts
The grooming process removes unnecessary data from the Operations Manager database in Grooming
order to maintain performance. For each data bype in the database, you can specify how Notificatior]
much time can pass before that data is deleted, Data deleted during database grooming is
not recoverable unless it has been specifically backed up. ations
CEIP
Operationg
Records ko delete | Older than | Error Repol
Ived Alerts 7 days
Event data 7 days Error Trang
Performance data 7 days .
ting 5
Task history 7 days Eporting -e
Monitoring job data 7 days e Web Cong
State change events data 7 days - Hed
Performance signature 2 days erver Hed
Maintenance mode history 7 days Security fo
Availability history 7 days

o]

Cancel Lpply |

eporlng
ﬁ Administration

NOTE: Data older than 7 days can be shown in a report (see section X of this document). The rule by
default will store the collected performance data in both the live database and the data warehouse.
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How do I create a performance monitor to monitor if a performance
counter sample exceeds a threshold?

Example: Create a monitor so | am alerted when CPU exceeds 80% usage on a server:

NOTE: Anything using a threshold is a monitor rather than a rule. The key difference between a monitor
and a rule, is that a monitor is state-based which means it will actually change the state of an object to
red (critical), yellow (warning) or green (healthy) in the state views. A rule is targeted to an object, but
will not change the health state of an object.

1) Navigate to Authoring and expand Management Pack Objects. Click Monitors>Create a Monitor>Unit
Monitor:

R System Center Dperations Manager 2007 R2 - antr2

File  Edt

Authoring 1 3 Actions ®

B |4 Authoring { Look far: | Find How Clear £

() Management Pack Tl
Distributed Applicatiog]_| = 9=" Type Inherited From | ma

S Groups Active Directory Site T Properties
B T Management Pack of -
Attributes

@ | @ CreateaMonitor ~ ;W

lonitor -

() treate a Monitor »

AEM Computer: DEPRECATED Enable

AEM User W, Overrides »

? v - Ak

il E -

H | Resources -
Agent Manager

Rules
=7 Service Level Tra -
= Tasks @ System Center Operations Manager Help
= Agentless Exception Monitoring Entities

B

3

Wiews

&Y System Cenker Operations Manager Orline
Agentless Managed Computer Group
Help

2]

)

Alert Notification Subscription Server
(@ about Monitors

(&) about Monitors
(@ How to Create a Unit Monitar

2]

All Network Devices

)

All Windows Computers

L3

Antoni Dey Servers
(@ How to Create a Dependency Rollup Monitor

2]

Antoni DFS Dist App
(® How to Create an Agaregate Rollup Moritor

L3

Antoni test Dcol-exchange

B

Antoni test Deol-exchange watcher computers group

3

antoni test web app

B

antoni test web app 7 urls

A9

G) Select a monitor above to view details

|l —r ()
Add Monitoring Wizard. .,
MNew Distributed Application. ..
Mew Group,..

! g mmlsralon

l. H orspace
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2) Navigate to Windows Performance Counters>Static Thresholds> Single Threshold>Simple Threshold
and change the Management Pack so something other than the Default Management Pack, and click
Next:

NOTE : This is a single threshold rather than a double threshold. A Single threshold has 2 states such as
healthy and critical when the threshold is exceeded. A double threshold monitor has 3 states such as
healthy, critical and warning and 2 thresholds are used to calculate which of these health states an
objectis in.
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Create a unit monitor ﬂ

. Select a Monitor Type

fdonitor Type .@ Help

General )
Select the type of monitor to create

Ferfarmance Counter

w1 SNMP
3wl Performance Counters
3 Log Files
3 Windows Events
3 Windows Services
o5 Windows Performance Counters
E Self Tuning T hrezhalds
-5 Static Thresholds
ﬁ Double Thresholds
215 Single Threshold
-.[) Awerage Threshold
() Consecutive Samples aver Threzhald
() Delta Threshold
) Simple Threshold
#-d Scripting
F-0 Wl Events

Threshaold W alue

Configure Health

Configure Alerts

Drescription: A, zimple threzhold monitar.

Management pack

Select destination management pack:

Antoni Customn Rules

<Erevinu&| Mext > I Create | Cancel |

A

3) Give the monitor a name (For Example: ‘XYZ Simple Threshold Monitor for CPU’), Select a Monitor
Target that will be present on the computer you want to monitor the performance counter on. In this
case an appropriate target is ‘Windows Server 2003 Operating System’ and then click Next:

NOTE: It is best practice to use some form of prefix or three-letter acronym as a naming convention, to
identify all of an organization’s custom rules and monitors. This makes it much easier to find custom
rules and monitors in the console when necessary.
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™

@ General Properties

Antoni Simple Threshald Manitor far CPU

Pefomarce =]

4) In the following dialog, ignore everything and click the ‘Select’ button;
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'.. Create a unit monitor

.'f' Performance Object, Counter, and Instance

I

tonitar Type .@ Help
General Specify the performance counter
Perfarmance Caunter Enter performance counter details or click Select to browse computers and zelect details.
Threshold Value Object:
Canfigure Health || 4 I
Configure Slerts Wildeard characters ® and ? are supported for advanced scenanos. Click help for more
infarmatian.
Counter:
Instance:
| o

I Include all instances for the selected counter

Select.. |

Specify the interval

Interval:

I 15 j IMinutes j

< Previous I et > Create Cancel

In computer, Browse to a computer that has the performance counter you need to collect and the
available object and counters in the list will refresh.

NOTE: This is purely for picking the correct counter. By selecting a computer to pick the counter from,
you are not saying ‘l just want to target this one computer’. Because in the previous dialogs we selected
SQL 2005 DB Engine, the performance counter rule will be activated on every Operations Manager agent
where a SQL 2005 DB engine object and the counter picked out is found.

Pick the appropriate object and counter and click OK:
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Select Performance Counter

Browse or enter computer name

Computer;

OPSMGR [

Performance counter

Obiject:

Frocessor 'I

Select counter from ligt;

C1 Time

C2 Time

C3 Time

DPC Time

Idle Time:
Interrupt Time
Privileged Time

Select instance from list:

e

0

BEE 0 50 00 30 50 20 0

% User Time
C1 Transitions/zec
C2 Trangitions/sec LI

Exzplain | [ &llinstances

1]

Cancel

Configure the interval / instances as required and click Next:
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@ Create a unit monitor

@ Performance Object, Counter, and Instance

pocesar ]

K

= T

Type the desired threshold value and click Next:
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@ Create a unit monitor

f- )| Threshold Value

Reconfigure the states if necessary or leave the defaults and click Next:

NOTE: You may need to reverse the states for example if you were monitoring Disk Space in MB and
want to change to critical if Over the threshold, and healthy if under the threshold
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'. Create a unit monitor

I onitor Type
General

Perfarmance Counter
Threshald ¥ alue
Configure Health

Configure Alerts

' Configure Health

Map monitor conditions to health states

@) Help

Specify what health state should be generated for each of the conditions that this monitor will detect:

tonitor Condition Operational State Health State
3 Under Threshald Under Threshald [ Healhu ™
Ovwver Threshold Ovwver Threshold | Critical

<Erevious| Mext » I LCreate Cancel

Place a check in the ‘Generate Alerts for this Monitor’ and optionally change the name to something
more meaningful. Also reconfigure the other settings like severity if needed and click Create:
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® Create a unit monitor

Configure Alerts

The manitar iz in a critical health state |—

Medum 7]

Instance $Data/Cortext/ rstanceMamed I_ Ciitieal ¥

Object $0ata/Contest/Objecty amed
Counter $0 ata/Contest/Countert amed
Has a value $Data/Context alued

At time $0 atasContext/Time S ampled$
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How do I run a report for a performance counter that OpsMgr is
collecting?

Note: This exercise assumes that Operations Manager 2007 reporting is already installed and that a
Performance Collection Rule already exists (either in an imported management pack or created in the
authoring space in a custom management pack) which is collecting the desired data.

The first step will illustrate how to create an ‘All Performance’ view which shows all the Performance
data that is currently being collected. This only needs to be done once and is used as a reference as to
which counters and rules are available.

If a new performance collection rule is created or a disabled one is enabled for the purposes of seeing
the performance data in a report, the data will not be available in reports until an hour later because the
data is aggregated on an hourly cycle. It is the aggregated data that is displayed in reports.

The steps below only need to be followed once to create a report. Once the report is created with all
the required parameters, objects etc, it can be saved to authored reports (by publishing it) or saved to
‘favorite reports’ and then be executed, without having to carry out the following steps each time the
report is ran.

This document uses the example of creating a performance report displaying the performance counter
SQL Server: SQL Statistics and Counter —Batch Requests /Sec. This data is collected by the Rule — ‘Antoni
Perf Rule SQL Server: SQL Statistics\Batch Requests/Sec’ which is targeted to all SQL 2005 DB Engines
(Created in section H of this document).

Outline of Steps (Fully Detailed Steps Commence on Next Page)

1) Create an 'All' Performance View in My Workspace
2) Identify the rule and target name(s) for the required Performance Counter

3) Open the Generic Performance Report
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4) Add the Required Chart and Series lines

5) Add an individual object to the first series line:

6) Add an individual object to any additional series lines:

7) Add the appropriate rule to the first series line

8) Add the appropriate rule to any additional series lines

9) Click OK in the settings dialog to confirm the settings.

10) Change the From value to a start time in the past, for instance use a previous day in the week.

11) Click Run

Detailed Steps

1) Create an 'All' Performance View in My Workspace using the steps in Section G of this Document.

2) Identify the rule and target name(s) for the required Performance Counter:
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BA System Center Operations Manager 2007 RZ - antr2

File  Edit

My Workspace
B 4 My Workspace
(] 3 Favorite Views
All Perf
(), Saved Searches

All' Perf

Mew View »

onitoring

W
W

20
154
104
5
]
515120 5/15/20 51520 5/15/20 5/15/20 51520 51520 51520 51520 515/20 515/20 51520
103:50 103:55 10400 104:05 104:10 10415 104:20 104:25 104:30 104:35 104:40 104:45
PM PM PM PM PM PM PM PM PM PM PM PM
All lkems ¥
Shaw | Calar | Path Target Rule Object Counker £ ‘ Instar=
[T == opsmgr.litware.c... opsmgrlitware.c... DataWarshouse... Opshge DWW Syn... Batch Age, sec healthe
[l opsmagr.litware.c... opsmagr.litware.c... Data Warehouse... OpsMgr DWW Swyn... Batch Age, sec typedn
[T = opsmgr.litware.c... opsmgrliware.c... DataWarshouse... Opshgr DW Syn... Batch Age, sec manag__|
- opsmgr litware.c... opsmar.litware.c... DataWarehouse... OpsMar DW Syn... Batch Age, sec config
[T == opsmgr.litware.c... opsmgrlitware.c... DataWarshouse... Opshge DWW Syn... Batch Age, sec domair
—
]

Antoni Perf Rule

Actions

Performance

Actions

hﬁ Save Image As...

Eg Copy Image to Clipboard
|53 Copy Data ko Clipboard
‘§§’ Select Time Range...

{1 Personalize view,..

Baseline
Resume the Baszline
Psuse the Baseline

Reset the Baseline

| S0L DB Engine Tasks

:3 Global Configuration Settings

._-:3 SQL Configuration Manager

L-zg 30L Management Studio

(35 se profiler

:3 Start SCL Agent Service from DE Enging

:3 Start SCL Agent Service on Cluster From DB Engine
:3 Start SGL Full Text Search Service

:3 Start SQL Full Text Search Service on Cluster

.:3 Start SOQL Server Service

:3 Start SOL Server Service on Cluster

:3 Stop SQL Agent Service from DB Engine

:3 Stop SGL Agent Service on Cluster from DB Engine
:3 Stop SGL Full Text Search Service

:3 Stop SGQL Full Text Search Service on Cluster

:3 Stop SQL Server Service

:3 Stop SGL Server Service on Cluster

!ﬂt DB !ngme Eepnr!s

Alert Logging Latency

opsmar.litware.c.

. opsmar.litware.c.

Data Warehouse. ..

OpsMar DWW Syn.. .

Eatch Size

opsmagr.litware.c...

opsmagr.litware.c

Data Warehouse. ..

OpsMar DW Sy,

Batch Size

opsmar.litware.c..,

opsmar.litware.c

Data Warehouse, .,

OpsMar DW Syn..

Batch Size

opsmar.litware.c...

opsmar.ltware.c...

Data Warehouse. ..

Eatch Size

a) Sort by Counter by clicking the counter column header

OpsMar DWW Syn.. .

b) Scroll down in the lower pane to find the Performance counter / object that you want to create a

report for.

NOTE: in this example, we will use the Object SQL Server: SQL Statistics and Counter —Batch Requests

/Sec

c) Right click the appropriate line and click ‘Show or Edit Rule properties’:
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m Antoni Perf Rule SQLSeryer: SOL Statistics’,Batch Requeskts Sec

General | Configurationl Product Knnwledgel Overides

Select rule name, description and target

Rule name:
Antoni Perf Rule SULS erver: SOL Statisticz\B atch Reguests/sec

Description [Optional]:

=l
id
M anagement Pack: Antoni Custom RBules
Rule Categary: Custom j

Rule target;

v Fule iz enabled

Ok, I Cancel | Apply

4

c) Note the ‘Rule Target’ and ‘Rule Name’ in the rule properties.

In this example:

Rule Name — Antoni Perf Rule SQL Server: SQL Statistics\Batch Requests/Sec

Rule Target — SQL 2005 DB Engine:

3) Open the Generic Performance Report

a) Click the reporting space and 'Microsoft Generic Reports Library' on the left

b) Double Click 'Performance’
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A System Center Dperations Manager 2007 B2 - antr2 -

@ |5 open
Microsoft Generic Report Library
[=l-{2 Reporting Mame +

Actions

L& Audit Reports & Alert Logging Latency
g Client Monitaring Yiews Library Alerts
--Lig) Microsoft Data Warehouse Reports avallabllity Schedule
--Li§) Microsoft Generic Report Library Configuration Changes X Delets
I:a Microsoft QDR Report Library Custnm Confiquration
-8 Microsoft Service Level Repart Library = g Diesign a new report
P ‘ Custom Event
~Lig 5L Server 2005 (Monitoring) event analysis |pesources |
= Ea Windows Server 2003 Operating System H h i SN
" X el _
I:a W!ndﬂws Server 2008 Operating S?»stam (I\f\nn\mr\ng) . @ System Center Oparations Mar
-8 Windows Server Internet Information Services 2003 .
N [a Authored Reports Most Common Alerts % System Center Operations Mar|
- Favorite Reports Most Cormmon Events
scheduled Reports Civerrides

Performance
Performance Detail
Performance Top Instances
Performance Top Cbjects

Performance [
Summary
This report shows selected objects and performance counter values

graphically over time —

Description:

lonitoring The report offers adding one or multiple charts and display data as

P historical chart or histograms. This report sources from hourly or daily
el aggregated data. For the selected time range the report allows to

report on performance data with charts and a data tables.

n'-" Reporting

W Parameters:
E‘WSDGCEP Data Aggregation: Report can be run using the hourly or daily

aggregations of data.

4) Add the Required Chart and Series lines
a) Click the 'Change' button near the top right of the window
b) In the settings dialog box, click the new chart button

c) Click the New Series button one or more times depending on how many datasets you would like your
graph to show. If you will be adding an object such as the Batch Request/Sec for 15 different SQL 2005
DB Engines, you would need to add 15 Series lines.

NOTE: In the example, | will add 2 SQL 2005 DB Engines (the SQL Server Instance and the SQL Express
Instance), so | click New Series twice.
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‘R performance - System Center Operations Manager 2007 RZ - Report — antr2

Eil=  Edit

P& Run B | E £ P [
Data Aagregation Objects Remoye |

[Houry |

e Color | Style | Scale | Rule | Instance I
[raday [ emeem =
Ta
[Tocsy EE =1/ =
Time Zone ~
I(GMT—US:DU) Eastern Time (U5 & Canada) List Mew Chart I Mew Series I Remave |

v
™ Uss business hours [ cater L sty [EZEET [ nstance [ Chject

v

8100 A to 5:00 P11 = [Chart] ¥

Man, Tue, Wed, Thu, Fri
Histagram ‘ I Cark Green =] Line 1

Mo

e Le s s

< | 1]
[~ Details
Chart title Objects Add Group. .. I fidd Ohiect... | Remove | Re
Browse. .
Ohject | Include | obje
€ Al instances
A
SULETED " Specific instances
Calor
I Light Elue -
Style
1] Line -
Scale
1.0000 Hﬁ
4 | |

oK Cancel

A

5) Add an individual object to the first series line:
a) Click on the first series and click Add Object

b) Click the Options button:
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Object Mame:

To add Objects to thiz report. search for the object. then add them to the "Selected objects" list.

21X

[EEETE— | |

Awailable items

Search

Options...

Mame | Clags

| Path

|

Selected objects

i

| Eemove |

Mame | Clazs

| Path

| LCancel |

c) Click the Add button:
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Search time interval ztart date:

Include objects from the following Management Groups:

| Satwdaw . EER  15.2010 x| [bel ari2
Search time interval end date:
| Satwday . May 152010 x|
Include ohigcts of the follawing class dd... Hemoyve
Class
4] | i

[u]4 I Cancel |

d) Type in all or part of the class name that you noted in Step 2, Search for it and add the exact

class then click OK:
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To filker the ‘fvailable Ikems' lisk by class, search For the class and then add them to the ‘Selected Objects' List,

Class Mame:

2l

Cantains

j Isql 2005 db en

Awailable tems

Search

Optians ==

M

EFELL

DBEngne
2005 DB Engine Group

Selected objects

Eemove

Mame

LalsoL

2005 DE Engine

LCancel

e) Click Ok in the Options dialog:
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Search time interval start date:

Include objects from the following Management Groups:

| Satuday . May 15,2010 x| [b] antr2

Search time interval end date:

| Satuday . May 15,2010 7|

Include objects of the following clazs

Bemowe |

Class

LAl 50U 2005 DB Engine

<

I ]

Ok

| Caticel |

f) With the Filter applied, click Search and all instances of the selected object should be

returned:
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To add Objects to this report, search for the object, then add them to the "Selected objects™ list,
Obiject Name:

ID:untains j I

1% Filter Options have been applied Search

Available itemz

I ame | Class | Fath
EMIEHDSDFT##SSEE SOUL DB Engine aparmgr libware, cann
EMSSE!LSEFWEF! SCEL DB Engine opzmar.libware. com

4| | i

Sdd | Eemowe |

Selected ohjects
I ame | Class | Path

4 | LCancel |

g) Pick ONE instance of the Objects, Add click OK

NOTE: Do not pick multiple instances. If you wish to add more than 2 instances (for instance 10 SQL
Servers) you will need to add 10 series lines (using the new series button) and then add an individual
instance to each series using steps Xx, Xx and X:
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To add Objects to this report, search for the object, then add them to the "Selected objects list.
Object Mame:
ICDntains j I
1% Filter Options have besn applisd Search Dptiors...
Awailable items
M ame I Class I Fath
EMICHDSDFTﬂﬂSSEE SCL DB Engine opzmgr.litware. com
EMSSQLSEH\-"EH SOL DB Engine opsmar. litware. canm
4| | i
E
Selected objects ﬂl
M anme | Clazz | Path
i aMSSGLSEHVEH SOL DB Engine opamagr.litware. com

1 |

i

LCancel |

7) Add the appropriate rule to the first series line

a) If not already selected, click the first series line that was added under the chart header

b) Click the Browse button next to Rule on the right-hand side of the Settings Dialog:
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N RS

List Mew Chart | MNew Series | Remove |
| color | sStyle | Scale | Rule | Instance | object
= [Chart]
Light Blue M8 Line
B Cark Green = Line 1
k3
Al
]
x|
1 | i
—Details
. . Rule
Chart title Objects Add Group. .. i Add Object, Remave [
I Browse. .. |
I Object | Include | obje
This object P ¢ Allinstances
[REEIENES ) (" Specific instances
Color
I I Light: Blue vl
Skyle
I =] Line vl
Scale
I 1.0000 3:
1] | i

()8 Cancel

c) Leave the default 'Search by Name' Selected and in the search box, type part or the entire rule
name noted in step 2 and click search:
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Belectrle 21|
Search By Name ISearch By Counter I
Rule name:
IContains j Iantoni
Management pack name:
fcaly =]
Search options == |
Available tems
Mame | Obiject | Counter | M anagement Pack I Fiuih
EAntoni Perf Fule SOLServer: SOL Statisticsh...  SOLServerSEL Statistics Batch Requests/sec Antoni Custom Fules S0l
Performance Collection: Transaction respon...  Web Application Total Web Application Response Time  antoni test mp ante
4| I i
Ok | Cancel |
|

Select the appropriate rule and click OK.

Click the next series without a rule or object assigned.

Repeat 6 and 7 for the next object you wish to add. When finished it should look something like this:

NOTE: although the rule name is cached and you will not need to search for it if using the same rule, you
will need to search for the object type again, apply the filter, search for instances and then add the

instance.
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emngs JT=IEY

List Mew Chark | Mews Serigs | Remove |
| Calor | Style | Scale | Rule | Instance | object
= [Chart]
I Light Blue ﬁ Line 1 Ankoni Perf Rule SQLServer: SQL StatisticsiBate. .. _E M3SQLSERVER.
M Line Antoni Perf Rule

| | i
—Details
Chart Hitle Objects &dd Group, | #dd Obiject. .. | Remove | Rule
|.cmtoni Perf Rule SQLS:
I Cibject | Include | Obije ;
PV # MICROSOFT##35EE This abject £/ Allimstances
" Specific instances
Colar
I I Dark Green j
Skyle
I =] Line j
Scale
| 1.0000 =
dl | 2

ak. Caticel

8) Click OK in the settings dialog to confirm the settings.

9) Change the From value to a start time in the past, for instance use a previous day in the week.
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™R performance - System Center Operations Manager 2007 R2 - Report - antr2

Edit Help
= run B9 L |

[rata Aggregation

= r- - CEIT

[Hourty

From

Ll

IToday

Specific date. .

| [ «saem

Advanced...

BBl LR

RIEEE=

Today

‘esterday

anada)

Sunday
Monday
Tuesday
Wednesday
Thursday
Friday
Saturday

s hiours, .

J L.

Objscts Change. .. Remave
Color | Skyle | Scale | Rule | Instance | Ghiject
I Light Blue ﬁ Line 1 Antoni Petf Rule SQLServer: SQL StatisticsiBate... Lﬁ MSSCLSERVER
I Dark Green =] Line 1 Antoni Perf Rule SQLServer: SOL Statistics\Bate. .,

L’E MICROSOFT##55EE = I

e Le 1>

Previous week 3
This manth 3
Previous month 3
[~ This quarter »
Previous quarter »
This year »
Previous year »

11) Click Run
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This was the report output using my example:

A performance - System Center Operations Manager 2007 R2 - Repor

File  Edit

E Click on plus sign to see a full description for this report

Report Time : 571642010 12:15 PM
Data Aggregation  Hourly
Report Duration : From 57172010 11:58 AM to 57/16/2010 11:58 &AM

Histogram i No

12—

o i + + -
5/15/2010 3:00:00 PM 5/15/2010 4:00:00 PM 5/15/2010 5:00:00 PM 5/16/2010 9:00:00 AM 5/16/2010 10:00:00 AM

Standard

Rule, Instance, Object Scale Sample Count Min Value Max Yalue Average Value Beoliing

Antoni PerfRule SQLServer: SQL
StatisticsBatch Requests/sec

I Objects(1)

SQL DB Engine: MICROSOFT##SSEE
antr2 | opsmar litware.com

B Antoni PerfRule SQLServer: SQL

Statistics'\Batch Requestsfsec ‘ 1 ‘ 133 6.748 | 19,03 9.414 2.863
T Objects(1)
SQL DB Engine: MSSQLSERVER
antr2 | opsmar litware.com
&l dates and times are shown in (GMT-05:00) Eastern Time (US & Canada) Page 1 of 1
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TIPS:

1) You can click the 'Show or Hide Parameter button' to bring back the parameters and modify the
report settings. Access the settings dialog using the Change button.

2) Once the report appears, you can use the File menu to perform one of the following options which
will remember the way in which you configured the report, allowing it to be re-ran by simply double
clicking it:

Save to favorites — This will save the report to the ‘Favorite Reports’ node which is user-profile specific
so the report will only be seen by the user who publishes it

Publish — This will save the report to the ‘Authored Reports’ node which is user-profile specific so the
report will only be seen by the user who publishes it

Save to Management Pack — Will allow you to specify an existing management pack or create a new one
to store the report in. This will create a new Folder under the reporting tree in the reporting space.
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How Do I Generate a Top ‘n’ Performance Report?

The Top ‘n’ reports are very powerful in that they can display the top ‘n’ server for CPU usage, memory
or any performance counter being collected by Operations Manager and stored in the warehouse.

Instructions:

1) Open the Performance Top Objects Report

2) Click the reporting space and 'Microsoft Generic Reports Library' on the left

3) Double Click 'Performance Top Objects’

4) Click the Browse button next to ‘Rule’ and pick out the appropriate rule (if required this can be
determined from the view created in Section G of this document)

5) Search for the appropriate rule name (e.g. for a report showing top ‘n’ objects for CPU usage, type
processor and click ‘Search’.

6) Choose the appropriate rule such as Processor % Processor Time Total 2003 and click ok.

7) Change the From and To fields to the desired timeframe.

8) Change the Algorithm from top N to Bottom N if appropriate for the counter being collected (e.g. if
running against % free space, Bottom N may be more appropriate)

9) Change the ‘n’ to the appropriate number. By default this is 5 and will therefore show the top 5 /
bottom 5 objects.

10) Click the Run button

PR performance Top Objects - System Center Operations Manager 2007 R2 - Repott - antr2

R m Center
ations Manager 2007 R2

Performance Top
Click on plus sign to see a full description For this report

Repart Time + SAB[Z010 956 AM

Repart Duration + From 1Li2009 to 5/16/2010

Management Group + antr?

Algorithrn i Tops

Fule + Pracessor % Procassor Time Total 2003
M Actions

Min Yaluz

1| | Windawes Operating System: Microsaft(F) Windaws(F) Server 2003,
Enterprise Edition

antrZ | opsmagr.litware com
2 | o Windows Operating System: Microso(R) Windows(F) Server 2003,

Enterprise Edition 30 0593 9BES 1102 .02
ant2 | DCOL.litweare com

2103

Al dates and times are shown in (GMT-DE00) Eastem Time (LS & Canada) Page 1of |
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How do I know what parameters are available in an event to monitor off?

High-Level Steps (Detailed Steps follow):

1) Create an Event collection rule to collect the event

2) Create an Event View in Operations Manager for collecting the Events (optional).

3) Query the DB to find which the table the events are being stored in, and then query the appropriate
table to get the event parameters.

Task 1 — Create an Event Collection Rule for the event you’re interested in, using the following steps

NOTE: An Event Collection Rule will only store the events in the Operations Manger database, making
them accessible via event views. It will not generate an alert when an event occurs — for the purpose of
generating an alert (from which email notification can be configured) use an Alert-generating rule.

Go to the Authoring space

1) Launch the Operator’s Console (Start>All Programs>System Center Operations Manager 2007
R2>0perations Console)

2) Click the ‘Authoring’ space on the bottom left hand side.

3) Right-click Management Pack Objects>Rules and choose ‘Create a new rule’

4) In the dialog, expand Collection Rules>Event based

5) Click ‘NT Event Log’

NOTE: A Golden rule of Operations Manager is to NOT store anything in the Default Management Pack.
See Section M of this document for explanation why.

6) Change the Management Pack from Default Management Pack to an appropriate Management Pack.
If there is an MP where all the company’s test rules and monitors are stored, then select it from the
dropdown. If not Create a new Management Pack by clicking the New button, give it a name, hit Next
and Create)
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7) With NT Event Log and the appropriate Management Pack selected, click Next:

IE Create Rule Wizard X
E Select aRule Type

Rule Type 1€ Help
General

Select the type of rule to create

Ewent Log Type —
-5 Alert Gererating Rules
23 Ewvent Bagzed
=1 Collection Rules
£1125 Evert Based

JE Generic C5W Text Log

4 Gen 0

MT Event Log

5 SNMP Trap [Event)

JE Syzlog

JB Wl Event

-1 Performance Bazed

-1 Prabe Bazed -
E1-l£% Timed Commands

JE Execute a Command j

|»

Euild Event Expression

Descrption:  Collect Windows events

Management pack

Select destination management pack:

<Erevious| Mest > I Create | Cancel |

8) Give the rule a name (For Example: ‘XYZ Event Collection Rule for 632 events’)

NOTE: It is best practice to use some form of prefix or three-letter acronym as a naming convention, to
identify all of an organization’s custom rules and monitors. This makes it much easier to find custom
rules in the console when necessary.

9) Click the ‘Select’ button next to the Rule target box and choose an appropriate target such as
'Windows Domain Controller and click OK.

NOTE: Because the 632 event will only occur on domain controllers, it is appropriate to target the rule to
the Windows domain controller object. If the event could occur on any windows computer, use
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‘Windows Operating System’ ,"Windows Server 2003 Operating System’ or ‘Windows Server 2008
Operating System’ as your target. Best practice is to be as specific as possible.

NOTE: Start typing the name of the object desired in the ‘Look For’ box to narrow the list down, and If
the object you‘re after is not available, click the ‘View all targets’ radio button.

Select Items to Targek x|

Select the class. group. or object that you want ta target from the list Below. You can alza filter or sort the list ta make
iterns easier to find.

Look for:

|wind0ws doma Clgar |

1ews common targets

™ iew all targets

Target - | Management Pack I Description |

79 tatal Targets, 2 vizsible, 1 zelected

Help | ok I Cancel |/
3

10) Leave the defaults of ‘Custom’ as the Category, ‘Rule is enabled’ checked and then click Next

NOTE: By leaving the Rule enabled, the rule will become active on every instance of the object you
target the rule to (e.g. every windows computer / every windows domain controller depending on the
object that you target). To target a specific instance or a subset of instanced, uncheck the ‘Rule is
Enable’ box to disable it by default and then following the creation of the rule, Create an Override to

enable for an instance or group of instances.
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I Create Rule Wizard

n Rule Name and Description

Fiule Type

General L
Select rule name, description and target

Event Log Type
Fiule name:

@) Help

Build Event Expression - -
IXYZ antoni event collection rule for 632 events

D ezcription [Dptional):

Management Pack: antoni test mp
Fiule Category: I Custam
Fiule target:

IWindows Cromain Contraller

¥ Rule iz enablzd

<% Previous

Mext »

Create

Cancel

11) In the Event Log Name, type the word Security, or alternatively, click the 3 dots and select the

Security Event Log, and click Next:

NOTE: This is nothing to do with the targeting. This is purely to make sure you get the name of the
event log correct with no typos. The Rule will look in the selected event log on every object targeted
(e.g. every windows computer or domain controller) that has the selected event log.
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IE Create Rule Wizard

r‘ Event Log Name

Fiule Type

General
Ewvent Log Type

Build Event Esprezsion

@) Help

Specify the event log to read the events from

Specify an event log name to read events from. You can browse to a computer to view and zelect
fram awvailable event logs.

Lag name:

ISecuritH _I

12) In the Value box on the Event ID line, type 632

NOTE: If you wish to collect a different Event, simply specify the alternative Event ID here.

13) In the box underneath, type the Event Source as it appears in the event. In the case of the 632
event, the Event Source is Security:
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Event Properties

Ewent |

Date:
Time:
Type:

Uger

502010 lﬁuurce: Security ] + I
34927 PM Categony: Account Management

. + |
Success A Ewent|D: E32

LIT'waRE \adminiztrator

Computer: DCO

Description:

Security Enabled Global Group Member Added:
Griffin,CH =Users, D C=litware, DC=com

Member Name: CM=Stewie

Member [D: LITWARE\StewieGriffin
Target Account Harme: Dromain Admins
Target Diomair: LITwWARE

Target Account ID: LITWARESDomain Admins
Caller User Mame:  administrator

Caller Domain: LITwaARE

Caller Logon 1D: [Ow0,0xE1120)

—

L

Data: §%) Bytes ) winrds

ST

ok I Cancel | Apply

14) Click Create:

B create Ruewird |

n Build Event Expression

Fiule Type

General

Event Log Type

Filter one or more events

Build the expression to filker one or more events:

Build Event Exprezzion

@) Help

E%Ingert - | Delete )( | Fgrmula'_’},‘;

Farameter Mame | Dperator

| Walue |

= AND group [all of these are true)

Event 1D Equals
» Event Source Equals
< Previous

632

ISecuritﬂ _I

Tewt > | Create I Cancel |

4
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Task 2 (Optional) — Create an Event View in Operations Manager for collecting the Events.

1) In the Operator’s console, Click the My Workspace space.

2) Right click Favorite Views, and choose New>Event View:

My Worlkspace

Ealder. ..
Alert Yiew
Event Yiew

Petfarmance Yiew

3) Give the view a name. In our case, a name like ‘All 632 events’ is relevant.
4) Place a check in the ‘with a specific event number’ criteria
5) Click the ‘specific’ hyperlink that appears in the criteria description box.

6) Type the event ID that you want to display (in our case 632) and click OK:
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=R System Center Dperations Manager 2007 R2 - antr2

Fle  Edit ¥
| —
My Worlcspace
= 48 My Warkspace

Favorite Views (1) Actions

\kl;ook for: I Find Maw Clear % Actio
£l 7§ Favarite Yiews
Ej All Perf Marme | Wiew Type | ‘ Crpen
\k Saved Searches 2] Al Perf Performance Yiew  Open ¥ Delete
(|
Mamne: arag
IAII 632 events
anag
Description: ||
B

Criteria | Display |

Show data related to: Show data contained in a specific group:

[ Entity |_| [= cay |_| gear|

Select conditions:

[[] generated by specific rules
with a specific event number

[ fram a specific source
[[] generated in specific time period

[] raised by an instance with a specific name il
ith ifi ity level X L
E ;:;mip:;;EF?:::;Iry e Enter a semi-calon delimited list of numbers

[ lagged by a specific camputer

Jead

Criteria description {click the underlined value ta edit): Cancel |
View all events:

with a specific event number

Mew Yiew »

Monitoring

(04 Cancel

Reporting

! E Aministration

_.“ My Workspace

7) Click OK in the Properties dialog

8) Verify that the new rule makes it down to the computer on which you intend the event to be
collected from by looking for a series of 1200, 1201 and 1210 events In the Operations Manager event
log (The 1201 event should show the name of the management pack that you created the rule in):
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File Action Wew Help

Ej Event Yiewer

= BEEFER @

@ Ewent Wiewer {Local)

Operations Manager 4,7

£ Application -
3| Security Tvpe Date Tirme Source Categar’ Ewent Liser Computer
i| System @Information S/16/2010 10:23:31 ...  HealthService Health 5... 1204 IS alali}]
i| Directory Service Jdnformakion  Gf16/2010 ... HealthService Health 5. L0l
DMS Server @Information Si16/2010 10:23:23 ... HealthService Healths... 1201 [IF [l e}
: File Replication Service @Information 5/16/2010 101722 ...  HealthService Health 5., 1200 IS Dol
i| Internet Explorer @Information 5f16/2010 10:17:20 ...  HealthService Health 5., 7028 [{IF:S [alati}
- £4l] Operations Manager glnformation Sf16/2010 10:17:20 ... HealthService Health 5., 7024 [IE D01
£ " LT " Elicing, sons b . = s .

Event Properties

Ewent |

D1 ate: Source: HealthService
Tirne: 101722 AM Categany: Health Service
Type: Information Ewent |0 1200

Uszer: P,

Computer: DCOT

Descriptiorn;

Mew b anagement Packlz] requested. b anagement group antr2",
configuration id:"76 C4 82 BB 723 AC 2C 24 4D 5E 34 3907 8F B4 C3 5C
9F1EB9 ™

For more information, see Help and Support Center at
hittpe A4 go.microzoft. comfwlink Aevent s aep.

Event Properties

Ewvent |

Drate: BAES2010  Souwrce: HealthService
Timne: 10:23:23 Ak Category: Health Service
Type: Information  Ewent [0: 1201

Uszer: M

Computer; DCO1

-

Dezcription:

Mew Management Pack with id:"'antoni.test. mp"', werzion:'1.0.0.0"
received.

For more information, see Help and Support Center at
http: A qo.ricrozoft. comnfwlinkAevents sep.
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Uszer:

Event Properties

Ewent |

D1 ate:
Tirne:
Type:

Descriptiorn;

BAES2010  Souwrce:  HealthService
10:23:31 AM Categary: Health Service
Information  Ewent |0 1210

I A

Computer: DCOT

2%

+..

M ew configuration became active. bManagement group antr2",
configuration id:"76 C4 82 BB 723 AC 2C 24 4D 5E 34 3907 8F B4 C3 5C
9F1EB9 ™

For more information, see Help and Support Center at
hittpe A4 go.microzoft. comfwlink Aevent s aep.

9) Repro the scenario so that an event is generated on the computer and collected in operations
Manager. In this example we added a user to domain admins and then saw the following event:
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A System Center Dperations Manager 2007 RZ - ankrZ

B 48 My workspace \%Lookfor: I Eind Mow Clear ®
Bl 3¢ Favorite Views =
(2] HU8 " Lewel | Diate and Time Source Marne /| Eve
@ All Perf @ Success dudit 51602010 10:34:45 AM Security DCO1 libware,com 632

x..k Saved Searches

: =

-

Dateand  5/16/2010 10:34:45  Description:

Time: AM Security Enabled Global Group Member Added:
Locancais Nty Member Name: CN=5Stewie
Source: Security Griffin,CN=Users,DC=litware, DC=com
Generating XYZ an_b:uni event N : o
Rule: collection rule for 532 Member ID: LITWARE\StewieGriffin
events ) )

Mew Yiew » Event - Target Account Name: Domain Admins

Mumber:

. Target Domain: LITWARE
' Monitoring Level: \D Success Audit
Loggi Target Account ID: LITWARE\Domain Admins
P 090nd - pegy
" Authoring Camputer: Caller User Mame: administrator

User: LITWARE Wdministrator

?" Reporting Caller Domain: LITWARE
. Administration Caller Logon ID: (0x0,0%9CBEC)
_. Privileges: - =
‘m. My Workspace
r ]
Event Data ~

Task 3 — Query the DB to find which the table the events are being stored in and then query the
appropriate table to get the event parameters.
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1) Open SQL Management Studio, Connect to the SQL Server hosting the OperationsManager Database
(this is the live operational DB where all the data presented in the Operator’s console is stored)

2) Click the ‘New Query’ button and change the DB dropdown from ‘Master’ to ‘OperationsManager’

File Edit i

: 0 =3

Object Explorer

Connect = | 4

ew  Query  Project

OperationsManager

BT

Tools

l- Microsoft SQL Server Management Studio

= 4 Data

[ Secu

e T e T Y

<]

= |y OPSMGR (SQL Server 9.0,3042 - LITWARE ad 4

hases

3 Swskem Databases

1 Database Snapshotks

| J M3Petshap

| | M3PetShopOrders

[J OperationsManager
[J OperationsManageraC
[J OperationsManagerD
| | ReportServer

[J ReportServer TempDE
| w3s_Content

rity

PR IR,

Ready

sl

Lnl

Window  Community  Help

PRl bewouery | [y [ER MR M| (B | S¥eidd B E BB S

= | B Exerute o W P05 | | 22| 3T

OPSMGR.Operat...SQLQuery2.sql

al

@ |EIF'SMGH [G.05P2]  |LITWARE \Administrator [25]

Cal 1 ch 1 INS o

3) Type and execute the following Query:

Select * from PartitionTables where iscurrent = 1
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crosoft SOL Server Management Studio

File Edit Wiew ©Query Project Tools ‘Window  Community  Help
Qtewoey |G| BREHBIESSEE BDIRES,
J¢ &Y Wy | OperationsManager - | ¥ Execute o 23 e | g7, tE

bl B IEE ]

w3

Connect~ | & wm T
=l | {§ OPSMGR (SQL Server 9.0,3042 - LITWARE | admini d
= [ Databases

[ System Databases

-]
Object Explorer Details ]

OPSMER, Operat, . . SOLQueryl .sql

[ Fiesults | 3 Messagesl

[ Database Snapshots

Dbjectld | Partitionld | PartitionName

| PartitionStart T ime | PartitionEndTime

| |sCurment |

| MsPetshop

| mMsPetshoporders

lJ OperationsManager
lJ OperationsManageraC
lJ OperationsManagerDi

2
2 2 3

HEEEFHEE

Event_03 20091016 00:38:31.473  2009-10-17 00:00:00.000
PerformanceData_03 20031016 00:38:31.573  2003-10-17 00:00:00.000

1
1

4) Note the name of the Event table listed, in the above example it is Event_03.

NOTE: This is the table that OperationsManager is writing all its collected event data to today.

Tomorrow it will be writing Event_04, and then Event_05 the next day and so on. The tables are

structured in this manner for more effective grooming.

5) Type and execute the following query (replacing Event_03) with the event table name returned by the

previous query:

Select * from event_03 where number = 632 order by timegenerated desc

icrosoft SOL Server Management Studio

Eile  Edit  Wiew Project  Tools  ‘window Community Help
Dewouery |y [ H 0 S| S idd BERES

| ggf_‘g OperationsManager - | B Execute o W

r
BewT
= L OPSMGR (SQL Server 9.0,3042 - LITWARE\admini
(1 [ Databases
[ System Databases
[ Database Snapshots 4

Connect *

order by timegenerated desc

B X
a0 2o g = a
i B o | 25|30 T B == -
OPSMGR.Opera...QLQueryZ.sql* |~ OPSMGR.Operat...5QLQueryl.sql [~ Object Explorer Details | - X
gelect * from event 03 where number = 832 =

| J MsPetshop

| MsPetshoparders 1 Resuls | [y Messages

|l OperationsManagsr Eventld

|l OperationsManageraC 93101FE1-053E-4411-84C4-7B 2866 1F 4188

l_] OperationsManagerDW
| ReportServer

|| ReportServerTempDE
| wss_Conkent

[ Security

[ Server Chiects

(3 Replication

[ 1 Management

ABGOBOGA-FCI0-AEOC-87B0-I066136FI57D
458994 26-9E OF-41FE-B600-4FEFA34B3010
04267470-4836-4ECE-8147-921BCIBE 5849
808425E 2-2406-47 25-AF8D -84 1437 2956F 7
ENA7CE23-4727-460 9-BA24-886B07E052E0
7B803562-DDA0-4011-4405-02D 34 3FAGABA

HEEHEEEHE

|“|m|‘-"|‘“|‘“|’\-‘ -

| EventOriginalld | Base... | Ruleld Publisherld Publishertame | F
4EF7C13D-7EEF-43D5-92E3BE12EE92CDDE 28 BCE035..  TE44DAZ2-CEDAME..  Securty
A06237CE-452C-4F5F-9F34-9D749FE35BDE 28 DDaAC TE44DA22-CEDA-AE..  Security
406237CE-452C-4F5F-9F34-9D749FEI9BDE 28 SC5035..  7E44DAZ2-CEDA4G..  Securty
3EGCFOFE-3429-4BA0AAED-105AFRESFFEE 28 DD2AC..  TE44DAZ2-CEDAME..  Securty
26024E96-98CA-444D-9ECO-451EDEA24458 28 DDaAC TE44DA22-CEDA-AE..  Security
24F45167-5893-4097 BE21-DD1A4BI06EE2 28 DD8AC..  7E44DAZ2-CEDAE..  Securty
150ATEFE-4551-4699-8BE5-46A1BATDE4EE 28 DD2AC..  TE44DAZ2-CEDAME..  Securty

ullNumber | N
632 &

632
632
632
632
632
632

32
632
632
632
632
632
632

urnber | Cate
7

LR IEN I N

6) The most recently collected event will be shown at the top. In the results, scroll across to the

EventParameters field:
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icrosoft SOL Server Management Studio =2 x|
Ele Edit “ew Query Project Tools  Mindow  Community  Help
2t cuery | (| 20 £ 00 | 3 | S ¥ i b 9 |2 DD BB B R
20 Al %97 | |OperationsManager [7] ¥ Execute o« W 30 Wk |2 | 3537 Em 3 =2 =K
OPSMGR.Opera...QLOuery2.sql* |~ OPSMGR, Operat.. SQLQueryl sql | Object Explorer Detalls | - X
Connect~ | 33w T select * from event 03 where number - 632 =
= | OPSMGR {SQL Server 9.0.3042 - LITWARE | admirni order by timegenerated desc I
= [ Databases
L& System Databases
[L3 Database Snapshats 4 |
| J MSPetShop Fesult T
| ) msPetshoporders & Resule | 1 Messages |
) OperationsManager oy | User [ Charnel [ Le [ LoggingComputer | EventD [ EventParameters TimelGenerated [ TimeAdded
l_l OperationsManageraC 1 LITwaARE \Administrator  Security 8 pcot <Param> CM=Stewie Griffin,CM=Users DC=litware DC=com<... | 2010-05-16 14:34:45000  2010-05-16 14:3%
|| operationsManagerD 2 LITWARE VA dministrator - Security 2 DCo <Param> CH=Stewie Griffin CM=Users DC=liware DC=com<...  2010-05-1614:28:39.000 20100516 14:2¢
u SEWT?"’E'T - 3 LITWARE \Administrator  Security 8 DCo <Param>CN=5tewie Griffin, CM=Users D C=liware, DC=cam< 2010-05-1614:28:33.000  2010-05-16 14:2¢
=
:jl WESDSDrCnirt\:rt e 4 LITwWARE \Administrator  Security 8 pcot <Param>CM=Stewie Griffin,CM=Uszers DC=litware. DC=com<...  2010-05-11 01:49:21.000  2010-05-11 01:4¢
3 Secur\tyi ] LITWARE VA dministrator - Security 2 DCo <Param> CH=Stewie Griffin,CM=Users DC=liware.DC=com<...  2010-05-11 01:42:46000  2010-05-11 014
[ Server Objects B LITWARE VA dministrator - Security 8 DCo <Param»cn=Stewie Griffin CN=Users DC=litware DC=com</..  2010-05-11 1:12:32.000  2010-05-11 01:12
[ Replication 7 LIT'wWaARE Administrator ~ Security 8 Dcot <Param>CM=bob CM=Users DC=litware D C=com</Paramp... 2010:01-1317:33:43.000  2010-01-1317:3¢
[ Management
=N ion Serui

7) Click the EventParameters field and copy out the contents:

EventParameters TimelGenerated
<Param:CN=5tewie Griffin CN=Users DC=liware . oy 34
<Param:CH=5tewie Griffin CH=Uzers DC=libware 2
Select Al
<Pararm:CH=5tewie Griffin CH=Uzerz, DC=libware 2

8) Open notepad and paste the contents there:

E'. Untitled - Notepad ;lglﬁ

File Edit Format  wiew Help

<Param>CH=S5Tewiea

criffin, CN=Users, DC=Titware, DC=Com< /Param><Param=LITwWARE St ewiecr 1T in</Param=<Param=Domain
Admins < Param=<Param>LITWARE</Param><ParamsLITwaAREYDomain

Admins < Param=<Param=administrator</Params<Param>LITWARE<,/Param=<Param>{0x0, 0x9CES8C )< /Par am:
<Params—</Params

e

9) Rearrange the contents of the notepad file, so a parameter is shown on each line:
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File Edit Format Wew Help

[P untitled - Notepad

<Param=Ch=stewie criffin,Ch=Users, dC=11Tware, DC=Ccom<Faram:
<Params>LITwARE ST ewiecriTTin</Param:

<Param=Domain admins<s/Params:

<Param>LITwWARE<Faram:

<Param>LITwWAREYDomain Admins</Param:
<Param=administrator<sParams

<Param>LITwWARE</Param:

<Param:>{0x0, DxSCERC )< /Params

<Params>—-</ Params:

The above is a numerically ordered list of parameters. So for instance:

Parameter 1 is the distinguished username

Parameter 2 is the Username

Parameter 3 is the Group name that the user was added to
Parameter 4 in the Domain Name

Parameter 5 is the Domain\Group Name

Parameter 6 is the user that made the change.

In Operations Manager, these parameters can be used to create a more granular event collection rule or

alert generating rule as outlined in Section E of this document:
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select an Event Property
‘f'ou can reference event properties that are common to all events.

You can alzo select event specific properties in the form of event
parameters. Refer to the specific event documentation for details.

" Select from a list of common event properties:

i Specify event specific parameter o use:

Ewent parameter number: 3 ﬁ

™ Usge parameter name not specified above:

oK I Cancel

16) In the operator field on the second line choose Equals

17) In the value field on the second line, type Domain Admins (Case-sensitive):

JEE Create Rule Wizard

- Build Event Expression

Rule: Type @ Hob
General

Filter one or more events
Event Log Type

Build the expression to fiter one of more events:
Build Event Expression

Configure Alerts S Insert - | Delete X ‘ Formula e

Parameter Name | Dperatar | Valus ]

= AND group (all of these are tiue]

E
R — )

<Previous || Hert> Cpeale Carcel |

.
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Appendix - Best Practices:

Management Pack / Override Best Practice:

First of all, the golden rule is please, please, please do not store anything (including overrides) in the
default management pack.

Another important best practice is to use a naming convention. So whenever you create a new
management pack, rule, monitor, group or anything, | would recommend that you always prefix it with
something like HRS.

This makes it a lot easier to find anything that you’ve created in the console.

An MP that you download from microsoft.com like AD / Exchange / SQL are all sealed management
packs. This means that you cannot change their contents in any way. If you look at the ‘Monitoring’
view in the console and the folders, you will see a lot of them have padlocks next to them and you will
not be able to right-click and create new views within the folders, because they are sealed

MPs. Likewise if you click on an alert and then click rule or monitor properties in the lower alert details
pane, in the rule or monitor properties, you will see that all the fields are grayed out and you cannot
change anything here.

So the only way you can customize a rule or a monitor such as whether it is enabled or disabled, or a
threshold for example, is by creating an override in an Unsealed Custom Management Pack.

When you go to override, you will see the ‘Default Management Pack’ as the option and if you click the
dropdown, it will show other available unsealed MPs and also gives you the option to create a new one.

Our recommended best practice is that for each sealed MP (let’s say you have SQL, AD and Exchange), is
that you have an unsealed MP, so in this example you would also have a MyCompany Custom SQL MP,
MyCompany Custom AD MP, MyCompany Custom Exchange MP and if you are overriding a rule in the
sealed SQL MP, you store the override in the MyCompany Custom SQL MP.

The reason for this and also the reason you don’t store anything in the default MP, is that when you
create an override, you create a dependency between the sealed MP and the unsealed MP.

So let’s say you didn’t know this best practice and had stored all your overrides (for SQL sealed MP, AD
Sealed MP, Exchange Sealed MP etc) in the default MP. If you then tried to remove one of those sealed
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MPs (let’s say SQL for example) from the console, it will prevent you from doing so, as it will say that you
have dependencies in the default management pack. In order to resolve this, you would need to
remove all the SQL overrides from the default MP before you can remove the sealed SQL MP. Another
way of resolving it, would be to delete the default management pack, but this is not recommended
because if you do that, you lose the top level views under monitoring. You can get them back, but for
this reason, we suggest that you don’t get into the situation where you need to delete the default MP, if
you can avoid it.

If you have followed best practice and have all your SQL overrides in your MyCompany Custom SQL MP,
that means if you needed to remove the sealed SQL MP one day, then the only MP you need to remove
first (that will have all dependent overrides) is the MyCompany Custom SQL MP, and you don’t have to

go anywhere near the default MP or any other management pack.

One tip here too, when you right click an alert to override the rule / monitor, and you see the flash out
menu to either ‘disable / enable’ or override, NEVER use the disable / enable flash out menu as this will
create an override to enable / disable and store it in the default management pack without giving you
the choice of which MP you’d like to store it in. So always use the ‘override’ flash-out menu instead
(even if you are just enabling * disabling) as this will allow you to control the MP the override is stored
in. Or alternatively, go into the rule / monitor properties and use the overrides tab there.
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